Tencor® FLX-2320
Thin Film
Stress Measurement
User Manual
COPYRIGHT NOTICE

Copyright © 1994, 1995 by TENCOR INSTRUMENTS. All rights reserved worldwide. No part of this publication may be reproduced, transmitted, transcribed, stored in a retrieval system or translated into any human or computer language, in any form or by any means, electronic, mechanical, magnetic, chemical, manual, or otherwise, without the express written permission of TENCOR INSTRUMENTS, 2400 Charleston Road, Mountain View, California, 94043.

WARRANTY

Except as otherwise indicated, Tencor Instruments warrants to the Buyer that the items sold by it hereunder are free from defects in material and workmanship and meet applicable specifications. In discharge of this warranty, Tencor Instruments agrees either to repair or replace as it may elect, any part or parts which under proper and normal use proves defective in material or workmanship within twelve months after delivery to Buyer, except for optional printers. If it is recognized that some components and accessories fail to give reasonable service for a reasonable period of time, as determined solely by Tencor Instruments, Tencor Instruments will at its election replace or repair them. Tencor Instruments may at any time discharge its warranty as to any item by refunding the purchase price and taking back the item.

Unless Buyer shall inspect all items and within thirty days of delivery notify Tencor Instruments of any apparent defects discovered and shall return the apparently defective item, transportation charges prepaid, to the Tencor Instruments factory or service office if so directed, Tencor Instruments shall have no liability hereunder.

The foregoing warranty and remedy are exclusive and Tencor Instruments shall have no other liability under any other warranty express or implied either in fact or by operation of law, statutory or otherwise. Tencor Instruments shall have no liability for special or consequential damages of any kind and from any cause arising out of the installation or use of any item.

TRADEMARKS

Tencor® is a registered trademark of Tencor Instruments.

PATENTS

This instrument is protected under the following patents: 5134303 and 524889.
AN IMPORTANT MESSAGE

Thank you for selecting the Tencor FLX-2320 and welcome to our growing world-wide family. Please read this manual carefully to familiarize yourself with the FLX-2320. The Tencor Instruments applications staff or the Tencor Instruments Service Department will be happy to assist you with any questions you have about your instrument.
OPERATING SAFETY

LASER

The Tencor FLX-2320 contains two solid-state lasers: a Class IIIa laser with 4 milliwatts (mW) power and 670 nanometers (nm) wavelength and a Class IIIb laser with 4 mW power and 750 nm wavelength. The lasers comply with Title 21 of the United States Code of Federal Regulations (CFR), Chapter 1, Subchapter J, Sections 1040.10 and 1040.11, as applicable.

Pursuant to the Regulations for the Administration and Enforcement of the Radiation Control for Health and Safety Act of 1968 (pertinent to laser products), a document describing this product has been filed with the Consumer Industrial Products Branch (HFZ-312) of the Division of Radiological Products of the National Center for Devices and Radiological Health (CDRH).

The CDRH requires that all laser products be maintained to keep them in compliance with CDRH's regulations. To maintain compliance with CDRH regulations, verify the operation of the Beam Attenuator (turns the laser beam off when the instrument door is open) annually or whenever the product has been subjected to adverse environmental conditions (mechanical shock, spilled solvents, and fire).

WARNING: Do not defeat the electrical or mechanical interlocks. When the interlocks are defeated, laser beams of Class IIIb medium power could be present. These beams are a safety hazard. Also avoid direct exposure to the laser beam.

Figure 1 indicates the location of the warning and information labels, laser controls, and safety controls on the Tencor FLX-2320. For a detailed explanation of the various controls, refer to Section 3.1, “System Components.”
Sample Certification and Identification and Interlock labels are displayed on the following page.

**WARNING:** Use of controls or adjustments, or performance of procedures other than those specified in this manual could result in hazardous light exposure. Do not remove the back cover of the instrument; service should be done by Tencor Instruments personnel only.

When operating the Tencor FLX-2320, comply with safety precautions described in this section; you can consult OSHA, ACGIH, and ANSI standards for additional guidance.

During instrument installation, instrument maintenance, or laser service, avoid unnecessary exposure to laser or collateral radiation exceeding the acceptable emission limits listed in the section titled "Performance Standards for Laser Products," in the CFR, Section 1040.10(d).
Sample identification label:

Model No. FLX 2320  
Serial No. 4198  
V: 115V  A: 12 Ph: 1 Hz: 60

Sample certification label:

Tencor® Instruments  
2400 Charleston Rd.  
Mountain View, CA 94043  
Manufactured: June 1993  
This product conforms to  
the applicable requirements  
of 21 CFR Subchapter J.

Sample interlock label:

DANGER – Visible and invisible  
laser radiation when open and  
interlock defeated.  
AVOID DIRECT EXPOSURE TO BEAM

VOLTAGE

The system contains components requiring electrical voltages of 115 V or 230 V.

WARNING: Disconnect all power connections before removing the instrument  
cover; the inside of the measurement platform contains voltages of  
115 V or 230 V.

HIGH TEMPERATURES

The hot plate and measurement platform are very hot (up to 500° C) when the heater is  
operating.

WARNING: Do not open the instrument door or touch the inside components  
or the wafer until cool.

LIFTING THE FLX-2320

The FLX-2320 is too heavy for one person to lift.

WARNING: One person should not attempt to lift the FLX-2320. Use at least two  
people to move the instrument.
REVISION LOG

This manual describes the FLX-2320 software version 4.2. Changes to this manual include

- The addition of safety information and labels on pages viii, ix, 2-6, and 2-7.
# TABLE OF CONTENTS

1 Introduction
   1.1 About This Manual
   1.2 How to Use This Manual
   1.3 Conventions Used in This Manual
      1.3.1 Typographic Formatting
      1.3.2 Terminology

2 Instrument Overview and Installation
   2.1 Instrument Overview
      2.1.1 Features
      2.1.2 System Components
   2.2 Operating Environment
   2.3 Shipping Contents
   2.4 Instrument Installation
      2.4.1 Shipping Damage
      2.4.2 Installing the Instrument
      2.4.3 Installing and Upgrading Software

3 Basic Skills
   3.1 System Components
   3.2 Using Application Windows
   3.3 Using the Trackball
   3.4 Using Menus
      3.4.1 Opening and Closing a Menu
      3.4.2 Selecting a Menu Item
      3.4.3 Menu Conventions
   3.5 Working With Dialog Boxes
      3.5.1 Text Boxes
      3.5.2 List Boxes
      3.5.3 Drop-down Lists
      3.5.4 Command Buttons
      3.5.5 Option Buttons
   3.6 Using Scroll Bars
   3.7 Working with System Messages
   3.8 Working with Data Display Windows
      3.8.1 Selecting Data Display Windows
      3.8.2 Minimizing a Data Display Window
      3.8.3 Maximizing a Data Display Window
      3.8.4 Restoring an Icon or Window to its Previous Size
      3.8.5 Moving Data Display Windows
      3.8.6 Resizing Data Display Windows
      3.8.7 Closing Data Display Windows
      3.8.8 Using the Active Window
3.9 Starting the Instrument 3-15
3.10 Main Menu, Submenus, and Submenu Options 3-15
3.11 Using Wafer Locator Rings 3-17
3.12 SECS Interface Option 3-19
  3.12.1 Communication and Control States 3-19
  3.12.2 Setting the SECS Parameters 3-20
  3.12.3 Uploading and Downloading Process Programs 3-22
  3.12.4 Terminal Messages 3-22
3.13 Shutting Down the Instrument 3-23

4 Performing Measurements 4-1
  4.1 Stress Measurements 4-1
    4.1.1 Setting up the Process Program 4-1
    4.1.2 First Stress Measurement 4-4
    4.1.3 Single Stress Measurement 4-7
    4.1.4 Stress-Time Measurement 4-8
    4.1.5 Stress-Temperature Measurement 4-10

5 Managing Data Files 5-1
  5.1 Working with Data Files 5-1
  5.2 Using File Menu Options in the Editor Window 5-1
    5.2.1 Displaying Additional Data Files 5-1
    5.2.2 Saving Data Files 5-2
    5.2.3 Renaming a File 5-3
    5.2.4 Merging Data Files 5-3
    5.2.5 Printing Data Files 5-3
    5.2.6 Printing Records 5-4
    5.2.7 Closing a Data File 5-4
  5.3 Edit Menu Options 5-4
    5.3.1 Editing Records 5-6
    5.3.2 Selecting Records 5-7
    5.3.3 Moving Records 5-7
    5.3.4 Copying Files 5-8
    5.3.5 Deleting Records 5-9
    5.3.6 Recalculating Stress 5-9
    5.3.7 Creating a No Film Record 5-10
  5.4 Exporting Data Files 5-10
  5.5 Graph Menu Option 5-10

6 Creating and Displaying Graphs 6-1
  6.1 Creating Graphs 6-1
    6.1.1 Using the Zoom Feature 6-3
  6.2 Creating a Trend Plot 6-4
  6.3 Displaying Graphs 6-8
  6.4 Using the File Menu in the Graph Window 6-9
    6.4.1 Renaming a File 6-10
    6.4.2 Merging Graphs 6-10
### Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.4.3</td>
<td>Printing a Graph</td>
<td>6-10</td>
</tr>
<tr>
<td>6.4.4</td>
<td>Deleting Graphs</td>
<td>6-10</td>
</tr>
<tr>
<td>6.4.5</td>
<td>Closing a Graph Window</td>
<td>6-10</td>
</tr>
<tr>
<td>6.5</td>
<td>Using the Font Menu in the Graph Window</td>
<td>6-10</td>
</tr>
<tr>
<td>6.5.1</td>
<td>Setting a Graph Header Style</td>
<td>6-10</td>
</tr>
<tr>
<td>6.5.2</td>
<td>Setting the Axis Header Style</td>
<td>6-11</td>
</tr>
<tr>
<td>6.5.3</td>
<td>Setting the Axis Label</td>
<td>6-11</td>
</tr>
<tr>
<td>6.5.4</td>
<td>Setting the Subtitle</td>
<td>6-11</td>
</tr>
<tr>
<td>6.5.5</td>
<td>Setting the Points</td>
<td>6-11</td>
</tr>
<tr>
<td>6.5.6</td>
<td>Saving the Graph File</td>
<td>6-11</td>
</tr>
<tr>
<td>6.6</td>
<td>Changing and Setting Points</td>
<td>6-11</td>
</tr>
<tr>
<td>6.6.1</td>
<td>Setting the Color of Points</td>
<td>6-12</td>
</tr>
<tr>
<td>6.6.2</td>
<td>Setting the Shape of Points on a Graph</td>
<td>6-12</td>
</tr>
<tr>
<td>6.6.3</td>
<td>Connecting and Disconnecting Lines on a Graph</td>
<td>6-12</td>
</tr>
<tr>
<td>6.7</td>
<td>Using the Axis Scale</td>
<td>6-12</td>
</tr>
<tr>
<td>6.8</td>
<td>Curve Fitting</td>
<td>6-13</td>
</tr>
<tr>
<td>6.9</td>
<td>Smoothing</td>
<td>6-13</td>
</tr>
<tr>
<td>6.10</td>
<td>Setting the Colors of a Graph</td>
<td>6-14</td>
</tr>
<tr>
<td>7</td>
<td>Data Analysis</td>
<td>7-1</td>
</tr>
<tr>
<td>7.1</td>
<td>Diffusion Coefficient</td>
<td>7-1</td>
</tr>
<tr>
<td>7.2</td>
<td>Materials Database</td>
<td>7-2</td>
</tr>
<tr>
<td>7.3</td>
<td>Elastic and Expansion Coefficient Calculation</td>
<td>7-4</td>
</tr>
<tr>
<td>7.3.1</td>
<td>Thermal Stress</td>
<td>7-6</td>
</tr>
<tr>
<td>7.4</td>
<td>Graph Subtraction</td>
<td>7-7</td>
</tr>
<tr>
<td>7.5</td>
<td>Comparing Records</td>
<td>7-9</td>
</tr>
<tr>
<td>7.5.1</td>
<td>Displaying Deflection Maps</td>
<td>7-15</td>
</tr>
<tr>
<td>8</td>
<td>Maintenance</td>
<td>8-1</td>
</tr>
<tr>
<td>8.1</td>
<td>Service Policy</td>
<td>8-1</td>
</tr>
<tr>
<td>8.2</td>
<td>Maintenance</td>
<td>8-2</td>
</tr>
<tr>
<td>8.3</td>
<td>Troubleshooting</td>
<td>8-2</td>
</tr>
<tr>
<td>8.4</td>
<td>Diagnostics</td>
<td>8-2</td>
</tr>
<tr>
<td>8.5</td>
<td>Calibration</td>
<td>8-4</td>
</tr>
<tr>
<td>8.5.1</td>
<td>Intensity Check</td>
<td>8-4</td>
</tr>
<tr>
<td>8.6</td>
<td>Moving the Laser Beam</td>
<td>8-5</td>
</tr>
<tr>
<td>8.7</td>
<td>Radius of Curvature Verification</td>
<td>8-6</td>
</tr>
<tr>
<td>8.8</td>
<td>System Configuration Information</td>
<td>8-11</td>
</tr>
<tr>
<td>9</td>
<td>Theory of Operation</td>
<td>9-1</td>
</tr>
</tbody>
</table>

**Appendix A** – Specifications A-1

**Appendix B** – Constants and Conversions B-1

**Appendix C** – FLX-2320 Cooling Stage (Option) C-1
<table>
<thead>
<tr>
<th>Glossary</th>
<th>GL-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Index</td>
<td>Index-1</td>
</tr>
</tbody>
</table>

#274526 Rev. B 9/95
# Table of Figures

## TABLE OF FIGURES

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 2-1</td>
<td>Tencor FLX-2320 (Front View)</td>
<td>2-2</td>
</tr>
<tr>
<td>Figure 2-2</td>
<td>Shockwatch Monitor</td>
<td>2-4</td>
</tr>
<tr>
<td>Figure 2-3</td>
<td>Tiltwatch Monitor</td>
<td>2-5</td>
</tr>
<tr>
<td>Figure 2-4</td>
<td>Tencor FLX-2320 (Rear View) Gas Connections</td>
<td>2-6</td>
</tr>
<tr>
<td>Figure 2-5</td>
<td>Tencor FLX-2320 Computer (Rear View)</td>
<td>2-7</td>
</tr>
<tr>
<td>Figure 2-6</td>
<td>Entering a User Name</td>
<td>2-8</td>
</tr>
<tr>
<td>Figure 2-7</td>
<td>Tencor FLX-2320 Main Menu</td>
<td>2-8</td>
</tr>
<tr>
<td>Figure 2-8</td>
<td>Process Program Dialog Box</td>
<td>2-9</td>
</tr>
<tr>
<td>Figure 2-9</td>
<td>Saving a Process</td>
<td>2-9</td>
</tr>
<tr>
<td>Figure 2-10</td>
<td>Diagnostics Dialog Box</td>
<td>2-10</td>
</tr>
<tr>
<td>Figure 3-1</td>
<td>Tencor FLX-2320 (Front View)</td>
<td>3-1</td>
</tr>
<tr>
<td>Figure 3-2</td>
<td>Window Structure</td>
<td>3-3</td>
</tr>
<tr>
<td>Figure 3-3</td>
<td>Menu Structure</td>
<td>3-5</td>
</tr>
<tr>
<td>Figure 3-4</td>
<td>Text Box</td>
<td>3-7</td>
</tr>
<tr>
<td>Figure 3-5</td>
<td>List Box</td>
<td>3-7</td>
</tr>
<tr>
<td>Figure 3-6</td>
<td>Drop-Down Button and List</td>
<td>3-8</td>
</tr>
<tr>
<td>Figure 3-10</td>
<td>Example of a System Message</td>
<td>3-12</td>
</tr>
<tr>
<td>Figure 3-11</td>
<td>Tencor FLX-2320 Main Menu</td>
<td>3-15</td>
</tr>
<tr>
<td>Figure 3-12</td>
<td>Main Menu, Submenus, and Options</td>
<td>3-16</td>
</tr>
<tr>
<td>Figure 3-13</td>
<td>Locator Ring used with Two Hot Plate Pins</td>
<td>3-17</td>
</tr>
<tr>
<td>Figure 3-14</td>
<td>Locator Ring used with Three Hot Plate Pins</td>
<td>3-18</td>
</tr>
<tr>
<td>Figure 3-15</td>
<td>SECS Parameters Dialog Box</td>
<td>3-19</td>
</tr>
<tr>
<td>Figure 3-16</td>
<td>SECS Parameters Dialog Box</td>
<td>3-20</td>
</tr>
<tr>
<td>Figure 3-17</td>
<td>Process Program Menu</td>
<td>3-22</td>
</tr>
<tr>
<td>Figure 3-18</td>
<td>SECS Parameters Dialog Box</td>
<td>3-22</td>
</tr>
<tr>
<td>Figure 3-19</td>
<td>View and Acknowledge Dialog Box</td>
<td>3-23</td>
</tr>
<tr>
<td>Figure 4-1</td>
<td>Process Program Dialog Box</td>
<td>4-2</td>
</tr>
<tr>
<td>Figure 4-2</td>
<td>List of Available Process Programs</td>
<td>4-2</td>
</tr>
<tr>
<td>Figure 4-3</td>
<td>First Stress Measurement Dialog Box</td>
<td>4-4</td>
</tr>
<tr>
<td>Figure 4-4</td>
<td>Sample Scan Profile and Graph Menu Bar</td>
<td>4-5</td>
</tr>
<tr>
<td>Figure 4-5</td>
<td>Displaying the Light Intensity</td>
<td>4-6</td>
</tr>
<tr>
<td>Figure 4-6</td>
<td>Saving the Graph Information</td>
<td>4-6</td>
</tr>
<tr>
<td>Figure 4-7</td>
<td>Single Stress Dialog Box</td>
<td>4-7</td>
</tr>
<tr>
<td>Figure 4-8</td>
<td>Stress-Time Dialog Box</td>
<td>4-9</td>
</tr>
<tr>
<td>Figure 4-9</td>
<td>Sample Stress-Time Graph</td>
<td>4-10</td>
</tr>
<tr>
<td>Figure 4-10</td>
<td>Stress-Temperature Dialog Box</td>
<td>4-11</td>
</tr>
<tr>
<td>Figure 4-11</td>
<td>File List of Recipes</td>
<td>4-12</td>
</tr>
</tbody>
</table>
Figure 4-12  Creating a Recipe  4-12
Figure 4-13  Saving a Recipe  4-13
Figure 4-14  Sample Stress-Temperature Graph  4-14

Figure 5-1  Loading Additional Data Files  5-2
Figure 5-2  Save As Dialog Box  5-3
Figure 5-3  Print Dialog Box  5-4
Figure 5-4  Entering a Data Filename  5-5
Figure 5-5  Data File Displayed in the Data Editor Window  5-5
Figure 5-6  Edit Menu  5-7
Figure 5-7  Data Editor Window  5-8
Figure 5-8  Edit Menu  5-8
Figure 5-9  Recalculating Stress  5-9

Figure 6-1  Create Graph Dialog Box  6-1
Figure 6-2  Sample Graph  6-3
Figure 6-3  Trend Plot Dialog Box  6-5
Figure 6-4  Sample Trend Plot  6-6
Figure 6-5  Table of Points Outside the Limits  6-7
Figure 6-6  Analysis Menu  6-8
Figure 6-7  Specifying the Graph File  6-8
Figure 6-8  Sample Graph  6-9

Figure 7-1  Filename Dialog Box  7-1
Figure 7-2  Diffusion Coefficient Extraction  7-2
Figure 7-3  List of Available Elastic and Expansion Coefficients  7-3
Figure 7-4  Elastic and Expansion Dialog Box  7-4
Figure 7-5  Sample Graph Displaying Cooling Curves  7-5
Figure 7-6  Sample Plotted Expansion Coefficient  7-5
Figure 7-7  Average Values of the Expansion Coefficient and Biaxial Modulus  7-6
Figure 7-8  Thermal Stress Dialog Box  7-6
Figure 7-9  Thermal Stress Superimposed on Stress-Temperature Measurement Data  7-7
Figure 7-10  Graph Subtraction Dialog Box  7-8
Figure 7-11  Record Comparison Dialog Box  7-9
Figure 7-12  Record Comparison Window  7-10
Figure 7-13  Edit Menu for Record Comparison  7-11
Figure 7-14  Deflection Graph  7-12
Figure 7-15  Stress Menu  7-12
Figure 7-16  Difference Graph  7-13
Figure 7-17  Displaying the Stress Uniformity Values  7-14
Figure 7-18  Sample Stress Uniformity Plot  7-14
Figure 7-19  3D Plotting from the Analysis Menu  7-16
Figure 7-20  Plot3D Menu  7-16
Figure 7-21  Group Selection Dialog Box  7-16
Figure 7-22  Displaying the Deflection Map File  7-17
<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8-1</td>
<td>Diagnostics Dialog Box</td>
<td>3</td>
</tr>
<tr>
<td>8-2</td>
<td>Utilities Menu</td>
<td>4</td>
</tr>
<tr>
<td>8-3</td>
<td>Utilities Menu</td>
<td>5</td>
</tr>
<tr>
<td>8-4</td>
<td>Laser Position Dialog Box</td>
<td>6</td>
</tr>
<tr>
<td>8-5</td>
<td>Mirror</td>
<td>7</td>
</tr>
<tr>
<td>8-6</td>
<td>6-in. Mirror Positioning Ring</td>
<td>8</td>
</tr>
<tr>
<td>8-7</td>
<td>8-in. Mirror Positioning Ring</td>
<td>8</td>
</tr>
<tr>
<td>8-8</td>
<td>Certification of Accuracy</td>
<td>9</td>
</tr>
<tr>
<td>8-9</td>
<td>Mirror Positioned in the Ring</td>
<td>10</td>
</tr>
<tr>
<td>8-10</td>
<td>Stress Measurement Menu</td>
<td>11</td>
</tr>
<tr>
<td>8-11</td>
<td>Choosing the Configuration Menu</td>
<td>11</td>
</tr>
<tr>
<td>8-12</td>
<td>Configuration Dialog Box</td>
<td>12</td>
</tr>
<tr>
<td>C-1</td>
<td>Instrument with Cooling Stage Option</td>
<td>1</td>
</tr>
<tr>
<td>C-3</td>
<td>Inert Gas and Liquid Nitrogen Connections</td>
<td>3</td>
</tr>
</tbody>
</table>
1 INTRODUCTION

1.1 ABOUT THIS MANUAL

This manual is divided into the following chapters:

- Chapter 1, "Introduction," provides information on the manual organization, conventions, and terminology.
- Chapter 2, "Instrument Overview and Installation," provides information on instrument features, installing the instrument, and installing and upgrading software.
- Chapter 3, "Basic Skills," provides information on instrument components and controls and on starting and shutting down the instrument.
- Chapter 4, "Performing Measurements," covers the measurement modes of first stress, single stress, stress-time, and stress-temperature.
- Chapter 5, "Managing Data Files," covers the Data Editor window, and the various functions that can be done within the window.
- Chapter 6, "Creating and Displaying Graphs," covers creating and displaying trend plots and graphs.
- Chapter 7, "Data Analysis," covers the various calculations, record comparisons, and analysis of data files.
- Chapter 8, "Maintenance," provides information on basic instrument maintenance, troubleshooting, calibration, and diagnostics.
- Chapter 9, "Theory of Operation," provides a brief overview of the theory of operation of the instrument.
- Appendixes describe the instrument specifications, and constants and conversions used in calculations, and the cooling stage option.
- A glossary and an index are also provided at the end of this manual.

1.2 HOW TO USE THIS MANUAL

To get the most out of this manual, you should work sequentially from Chapter 3, "Basic Skills," through Chapter 7, "Data Analysis." Chapter 8, "Maintenance," should be used by the key person responsible for maintaining the instrument.

CAUTION: We also strongly recommend that you read the section on Operating Safety on page vii before operating the instrument.
1.3 CONVENTIONS USED IN THIS MANUAL

This manual uses the following typographic formatting and symbols to make your learning experience faster and easier.

1.3.1 TYPOGRAPHIC FORMATTING

Keep these conventions in mind while reading the manual:

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bold</td>
<td>Messages and examples appear in bold text.</td>
</tr>
<tr>
<td>F2</td>
<td>The keys or buttons you must press appear in small, capitalized letters.</td>
</tr>
<tr>
<td>File menu</td>
<td>Tencor FLX-2320 menus and windows are shown with initial capital letters.</td>
</tr>
<tr>
<td>[←] [→] [↑] [↓]</td>
<td>The arrow keys on the keyboard move the selection bar around the display. To select an option, press the arrow key pointing in the desired direction until the selection bar highlights the option.</td>
</tr>
<tr>
<td>Enter</td>
<td>The word <em>enter</em> is often used in conjunction with data that you type using the keyboard. To <em>enter</em> data means to type the words or data and press the ENTER key.</td>
</tr>
</tbody>
</table>

1.3.2 TERMINOLOGY

Before continuing, you need to familiarize yourself with several terms used throughout this publication.

**Application**

A software program such as the Tencor FLX-2320 application. Applications occupy the full display screen when operating, if not iconified or if the maximized button is off.

**Arrow Keys**

The four arrow keys on the computer keyboard. Each arrow key points in a specific direction. To move the selection bar in menus, press [↓] to move the bar downward and [↑] to move the bar upward. To activate the menu item, press ALT, and then use the arrow keys to select any menu. Press [→] to select menus left to right and [←] to select menus right to left.

**Command**

The action associated with one of the options appearing on a menu and activities performed when keys are pressed on the keyboard.
Cursor
Small blinking dash appearing in the alphanumeric fields. The cursor serves as a pointer marking the location where characters appear when you type.

Directory
Computer files are stored on the computer’s hard disk in directories. The directory name identifies the location where the files are stored.

Field
Reserved area provided on many windows for typing data, displaying data, or selecting options associated with the field. Three types of fields can appear on windows—data entry fields, option fields, and display-only fields. Data entry fields are reserved for typing numeric values or alphanumeric data. Option fields have predefined values. Display-only fields are used by the instrument to display the current status of hardware.

Highlight
A field that has a different background from the other fields indicating that the highlighted field is to be replaced.

Keyboard
All instrument operations are done using the arrow keys, [←] [→] [↑] [↓], on the keyboard.

Menu
A list of actions. For example, the File menu contains file related actions. Inactive items in the menus are dimmed.

Process Program
A process program is a set of parameters specifying information such as the number of scan points, elastic modulus, substrate thickness, and wafer diameter for the measurement.

Scan
Action performed when the Tencor FLX-2320 optical system and measurement stage are used to inspect wafers.

Screen
Generic term used to describe the information appearing on the computer display at any given moment.

Trackball
All instrument operations are done using the trackball or computer keyboard.
Trackball Pointer

The arrow shaped cursor on the screen that follows the movement of a trackball (or other pointing device) and indicates which area of the screen will be affected when you press the trackball button. The pointer might change shape during certain tasks.

Window

Small to large rectangular boxes that open on the screen.
2 INSTRUMENT OVERVIEW AND INSTALLATION

This chapter provides information on the following:

- Instrument features
- Operating environment and site requirements
- Procedures for installing the instrument and software
- Procedures for installing upgrades to the software

2.1 INSTRUMENT OVERVIEW

2.1.1 FEATURES

The Tencor FLX-2320 is a thin-film stress measurement instrument. It accurately measures the changes in the radius of curvature of the substrate caused by the deposition of a stressed thin film on the substrate. Some of the features include:

- Laser scanning technology to accurately measure stress on all reflecting films. You can also measure stress as a function of time or temperature (standard temperature range from room temperature to 500° C; optional temperature range -65° C to 500° C). The software displays regular and time-dependent stress measurements in graph form automatically.
- An optional inert atmosphere capability that allows measurements to be made in a controlled atmosphere of nitrogen or argon.
- Software leveling of the sample which provides more accurate results.
- Only one moving element in the optical components ensures low vibration and high accuracy.
- Ability to customize parameters such as number of scan points, elastic modulus, substrate thickness, and wafer diameter in the process programs. You can specify heating and cooling cycles in the recipe for stress-temperature measurements.
- Ability to edit data records, plot graphs, and trend charts. You can also automatically recalculate the stress for a saved data file by changing the elastic modulus, wafer, or film thickness.
- Comprehensive data analysis capabilities that include calculating the biaxial modulus of elasticity and linear expansion coefficient, displaying thermal stress superimposed on stress-temperature measurement data, stress uniformity, file subtraction, trend plotting for statistical process control (SPC), calculating the water diffusion coefficient in dielectric films, and displaying a 3-D map of the deflection over the wafer.
- Menus, screens, and windows that are simple and easy to use. Key operation for each field is usually displayed at the bottom of the screen.
2.1.2 SYSTEM COMPONENTS

The Tencor FLX-2320 system consists of a computer, computer keyboard with a built-in trackball, and a measurement unit. Figure 2-1 shows the measurement unit with its door open. Inside the cabinet you can see the hot plate, dial indicator, and the four thumbscrews that hold down the hot plate cover.

Figure 2-1  Tencor FLX-2320 (Front View)

The temperature display, heater switch, fan switch, laser keyswitch, and the main On/Off switch are located along the top front of the cabinet. For a detailed explanation of the instrument components and controls, refer to Section 3.1, “System Components.”
2.2 OPERATING ENVIRONMENT

The instrument must be installed on a reasonably flat, rigid foundation.

Facility Specification

<table>
<thead>
<tr>
<th>Specification</th>
<th>Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature</td>
<td>18–22°C (64–72°F)</td>
</tr>
<tr>
<td>Air Quality</td>
<td>Class 100 or cleaner</td>
</tr>
<tr>
<td>Gas Connections (Standard instrument)</td>
<td>Inert gas flow rate: 2–10 CFH; Cooling gas flow rate: Up to 500 CFH; pressure not to exceed 40 psi. Note: The cooling gas cools the hot plate from 500°C to room temperature in 60 min.</td>
</tr>
</tbody>
</table>
| System Power           | 11 amp. at 110 V, 50/60 Hz
                          | 200-mm option: 13 amp. at 230 V, 50/60 Hz |

**CAUTION:** Avoid operating the Tencor FLX-2320 near strong electrical and magnetic fields, emitters of radio frequency interference, sources of mechanical vibration, or contaminating or corrosive vapors.

2.3 SHIPPING CONTENTS

The following items are shipped with the unit:

- Two Tencor FLX-2320 manuals
- One Tencor FLX-2320 software diskette

2.4 INSTRUMENT INSTALLATION

2.4.1 SHIPPING DAMAGE

**NOTE:** The carrier is responsible for damage incurred during shipping and should be contacted immediately if the shipping containers appear damaged (see below). Be sure to retain all damaged containers and documentation for inspection by the carrier.

Each shipping container has a Shockwatch monitor and a Tiltwatch monitor on the outside of the container. Sample labels are displayed here.
SHOCKWATCH MONITOR

IF SHOCKWATCH INDICATOR IS RED

1. DO NOT REFUSE SHIPMENT.
2. MAKE NOTATION ON DELIVERY RECEIPT AND INSPECT FOR DAMAGE.
3. IF DAMAGE IS DISCOVERED, LEAVE IN ORIGINAL CONTAINER AND PACKAGING, AND REQUEST IMMEDIATE INSPECTION FROM CARRIER WITHIN 15 DAYS OF DELIVERY. (ATT. 3 DAYS)

Figure 2-2  Shockwatch Monitor

If the shockwatch indicator in the middle of the monitor is red, the crate was not properly handled. Note that normal movements and acute angles during aircraft take-off and landing do not activate the indicator. If the indicator is red, make a notation on the bill of lading and service report and check the instrument for damage. If the instrument is damaged, notify the carrier and the service dispatcher at Tencor Instruments.

Also verify that the sticker “FACTORY SEALED, Tencor Instruments Inc., Mtn. View, Calif.” is still intact. If the seal is not in place, the instrument could have been mishandled by the carrier. If the seal is missing or not in place, make a note on the Service Report. Check the instrument for damage and notify the carrier and the service dispatcher at Tencor Instruments in case of damage.
TILTWATCH MONITOR

Figure 2-3  Tiltwatch Monitor

If the indicator in the center of the label is red (normal state is white), then the container was tilted on its side or completely upended. Note that normal movements and acute angles during aircraft take-off and landing do not activate the indicator. If the indicator is red, there could be possible damage to the instrument. Make a note on the bill of lading and the Service Report. Check the instrument carefully for damage and notify the carrier and the service dispatcher at Tencor Instruments in case of damage.

2.4.2 INSTALLING THE INSTRUMENT

CAUTION: We strongly recommend that you read the section on Operating Safety on page v before installing the instrument.

To install the instrument you need to do the following:

- Make the optional gas connections. Note: If your instrument is equipped with the cooling stage option, refer to Appendix C, “FLX-2320 Cooling Stage (Option),” for nitrogen gas and liquid nitrogen connections.
- Connect instrument and computer components.
- Set up the desired process program.
- Level the measurement platform.

NOTE: You do not need to verify the measured radius of curvature for the instrument. Before each instrument is shipped, its radius of curvature is verified. If you wish to verify the radius of curvature, you can order special mirrors and rings for the verification. See
Section 8.7, "Radius of Curvature Verification," for details. Also note that this verification option is only available for the 6-in. and 8-in. wafer instruments.

All the procedures are explained in the following sections.

To install the instrument:

1. Connect the inert and cooling gas for the standard instrument:
   - The inert and cooling gas pipes are connected at the back of the instrument. See Figure 2-4 for the location of the connections. The instrument gas connections consist of four, assembled, 1/4-in. Swagelok bulkhead unions (Swagelok Part No. SS-600-61).
   - To connect the gas pipes (stainless steel or Teflon), remove the nut, the back ferrule, and the front ferrule on each Swagelok. Place the nut and the two ferrules on each pipe and then connect it to the corresponding Swagelok.

![Diagram of gas connections](image)

**Figure 2-4  Tencor FLX-2320 (Rear View) Gas Connections**

Note: The connections in Figure 2-4 and the following gas flow specifications are for the standard instrument. For the cooling stage option, refer to Appendix C, "FLX-2320 Cooling Stage (Option)."
Gas Flow Specifications

Danger

Inert Gas Flow Rate 2–10 CFH; nitrogen or argon, 5-10 psi
Cooling Gas Flow Rate Up to 50 CFH compressed air; pressure not to exceed 40 psi
Note: The cooling gas cools the hot plate from 500° C to room temperature in 60 min.

2. Attach the Dial Indicator and the leveling screw to the right of the measurement platform as shown in Figure 2-1.

3. Connect the 40-pin and 50-pin flat cables attached at the back of the instrument to the computer as shown in Figure 2-5.

Figure 2-5  Tencor FLX-2320 Computer (Rear View)

4. Connect the 9-pin connector of the RS-232 cable to the Serial Port 1 on the back of the computer and the 25-pin connector of the RS-232 cable to the back of the instrument as shown in Figure 2-5.

5. Connect the monitor, keyboard, and printer (if you have one) to the computer. See Figure 2-5 for the location of the various ports on the computer.

CAUTION: If your instrument is equipped with the 200-mm (8-in.) option, the instrument must be connected to a 220 V electrical supply.
6. Plug in the electrical power for the instrument and the computer. Proceed to the following section, "To set up the process program."

To set up the process program:

The process program specifies parameters such as the number of scan points, the elastic modulus, the substrate thickness, and the wafer diameter. When you select measurement modes, the last selected process program is always displayed. At that point you have the option of selecting another process program or continuing with the last process program selected. Tencor Instruments provides sample process programs for the 100-mm, 125-mm, and 150-mm wafers.

1. Turn the computer on. The computer automatically loads the software and displays the Tencor FLX-2320 Main menu with the login user name dialog box (Fig 2-6).

![Figure 2-6 Entering a User Name](image)

2. Key in a user name and choose OK. You can add and delete users by choosing User under the Edit menu. The main menu displays (Fig. 2-7).

![Figure 2-7 Tencor FLX-2320 Main Menu](image)

3. From the Edit menu, choose Process Programs. The Process Program dialog box appears (Fig. 2-8).
4. The first time, the system default values are displayed. Make sure the Auto Scan field is set to On.

5. If you make changes, save the process program, by choosing the Save button. A file directory dialog box, similar to the following displays.

Figure 2-8  Process Program Dialog Box

Figure 2-9  Saving a Process
Enter the desired process name or choose OK to accept the default filename.

NOTE: The Tencor Instruments Service engineer will install the final gas and water connections and the quartz furnace chamber, and level the measurement pedestal and furnace chamber. The following leveling procedures are provided for your information only.

To level the measurement pedestal:

1. Display the Main menu:
   - If the software is already operating, let the current operation come to a stop, then press ESC until the Main menu is displayed (Fig. 2-7).
   - If the power is turned off, turn on the computer. The system loads the software and displays the user login dialog box and Main menu (Fig. 2-7).

2. Load a bare, silicon wafer in the instrument:
   - Open the instrument door (Fig. 2-1).
   - Loosen the four screws that hold down the hot plate cover (Fig. 2-1). Remove the screws and the hot plate cover.
   - Place the wafer, face up, in the shallow depression in the center of the hot plate. You do not need to replace the hot plate cover for this test. Close the instrument door.

3. Choose Diagnostics from the Utilities menu. The instrument checks the reflected light intensity (SUM) and the beam positions (DIFF) and displays the information along with other hardware information in the Diagnostics dialog box (Fig. 2-10).

<table>
<thead>
<tr>
<th>Diagnostic</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS232: CONNECTED</td>
<td></td>
</tr>
<tr>
<td>Temperature controller:</td>
<td>ON</td>
</tr>
<tr>
<td>Parallel port printer:</td>
<td>CONNECTED</td>
</tr>
<tr>
<td>7 serial ports installed</td>
<td></td>
</tr>
<tr>
<td>Motor functioning:</td>
<td>OK</td>
</tr>
<tr>
<td>670m intensity:</td>
<td>HIGH</td>
</tr>
<tr>
<td>Sum = 4.981</td>
<td>Diff = -0.068</td>
</tr>
<tr>
<td>Table leveling (670m):</td>
<td>OK</td>
</tr>
<tr>
<td>750m intensity:</td>
<td>HIGH</td>
</tr>
<tr>
<td>Sum = 4.971</td>
<td>Diff = -0.064</td>
</tr>
<tr>
<td>Table leveling (750m):</td>
<td>OK</td>
</tr>
</tbody>
</table>

Figure 2-10 Diagnostics Dialog Box
4. Use the information displayed in the Diagnostics dialog box to make sure the cables, drives, and instrument are installed and functioning. The following list explains the information displayed.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232</td>
<td>Status of the cable connector used to check the instrument temperature. The default setting is Connected.</td>
</tr>
<tr>
<td>Parallel port printer</td>
<td>Status of the parallel printer port.</td>
</tr>
<tr>
<td>Temperature controller</td>
<td>Status of temperature controller.</td>
</tr>
<tr>
<td>Serial ports installed</td>
<td>Number of serial ports installed.</td>
</tr>
<tr>
<td>Motor functioning</td>
<td>Status of the motor.</td>
</tr>
<tr>
<td>670 nm intensity</td>
<td>SUM is the reflected light intensity; DIFF is the beam position for the 670-nm laser.</td>
</tr>
<tr>
<td>SUM = ; DIFF = Table leveling (670 nm)</td>
<td>Indicates if the measurement platform needs to be leveled by turning the leveling screw clockwise or counterclockwise.</td>
</tr>
<tr>
<td>750 nm intensity</td>
<td>SUM is the reflected light intensity; DIFF is the beam position for the 750-nm laser.</td>
</tr>
<tr>
<td>SUM = ; DIFF = Table leveling (750 nm)</td>
<td>Indicates if the measurement platform needs to be leveled by turning the leveling screw clockwise or counterclockwise.</td>
</tr>
</tbody>
</table>

5. To level the measurement pedestal, read the value in the DIFF field for the 670 laser field. The DIFF field displays the laser beam position.

6. For a bare silicon wafer, the value in the DIFF field should be -0.1 to +0.1. The Table Leveling field below the laser field indicates whether the leveling screw should be turned clockwise or counterclockwise. Adjust the leveling screw until the value in the DIFF field is within the specified limits.

2.4.3 INSTALLING AND UPGRADING SOFTWARE

Tencor Instruments installs the FLX-2320 software before the instrument is shipped. However, if a serious software or hardware problem occurs, you might need to reinstall the software. You will also need to install upgrades to the software. Use the instructions in this section to reinstall software. For upgrades, follow the instructions provided with the upgrade diskettes.
To reinstall the software:

1. Insert the Tencor FLX-2320 software diskette into the floppy disk drive.
2. Exit the Tencor FLX software.
3. From the Program Manager in windows, choose Run from the File menu.
4. When setup is completed, reboot the system.
5. Type a:setup and press OK.
6. Start the Tencor FLX software.
3 BASIC SKILLS

Chapter 3 covers the following introductory procedures:

- Using instrument controls
- Using pull-down menus and dialog boxes
- Creating a directory for storing data
- Working with system messages
- Starting the system and selecting options
- Loading and unloading wafers for all measurement modes
- Shutting down the system

3.1 SYSTEM COMPONENTS

FLX-2320 is shipped with a separate computer, computer keyboard with built-in trackball, and the FLX-2320 instrument. Figure 3-1 displays the instrument controls.

Figure 3-1 Tencor FLX-2320 (Front View)
### WARNING:
The hot plate cover and the four thumbscrews are hot (up to 500° C) while the heater is operating. DO NOT touch the hot plate or screws until cool.

See the following table for a brief description and setting of each control indicated in Figure 3-1.

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature Display</td>
<td>Displays the temperature heating and cooling cycle when measuring stress using the Stress-Temperature Measurement mode.</td>
</tr>
<tr>
<td>Heater Switch</td>
<td>Turns on the heater for the Stress-Temperature Measurements.</td>
</tr>
<tr>
<td>Fan Switch</td>
<td>Turns the fan On or Off. If using the Stress-Temperature Measurement mode, turn on the fan before loading the wafer.</td>
</tr>
<tr>
<td>Laser Keyswitch</td>
<td>The laser keyswitch turns the lasers On or Off. This keyswitch should always be in the On position when operating the instrument.</td>
</tr>
<tr>
<td>Main On/Off Switch</td>
<td>The main On/Off switch should always be in the On position when operating the instrument.</td>
</tr>
<tr>
<td>Beam Attenuator</td>
<td>The beam attenuator blocks the laser beams mechanically when you open the door to the instrument.</td>
</tr>
<tr>
<td>Dial Indicator</td>
<td>The dial indicator is used for calibrating the instrument.</td>
</tr>
<tr>
<td>Leveling Screw</td>
<td>The leveling screw is used to level the measurement platform. The Diagnostics window indicates whether this screw should be turned clockwise or counterclockwise to level the platform.</td>
</tr>
</tbody>
</table>
3.2 USING APPLICATION WINDOWS

The Tencor FLX-2320 software runs in an application window. Application windows have common elements, but not all elements are used in every application window. Figure 3-2 shows a typical window structure for an application.

![Application Window Structure](image)

**Figure 3-2** Window Structure

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Menu</td>
<td>A menu that contains commands you can use to manipulate the window. Control menus can also be found in application icons and some dialog boxes.</td>
</tr>
<tr>
<td>Title Bar</td>
<td>The title bar displays the name of the application and can contain other information.</td>
</tr>
<tr>
<td>Minimize Button</td>
<td>Click on this button to reduce the window to an icon. To redisplay the window, double-click on the icon.</td>
</tr>
<tr>
<td>Maximize Button</td>
<td>Click on this button to enlarge the window to its maximum size.</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>The menu bar lists the menus provided by the application. Menus contain items that perform actions.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Menu</td>
<td>A menu contains a list of actions. For example, the File menu contains file-related actions. Inactive items in the menus are dimmed (shown in gray).</td>
</tr>
<tr>
<td>Application</td>
<td>Most of the work taking place while using an application is performed in the workspace. The workspace displays the results of measurements, for example, data display windows.</td>
</tr>
<tr>
<td>Workspace</td>
<td>Tool Bar The tool bar contains buttons that allow you to choose commands quickly.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>This area displays informational messages and directions for the active window.</td>
</tr>
</tbody>
</table>

### 3.3 USING THE TRACKBALL

The trackball is the primary device you use to interact with FLX-2320. The trackball provides a method of manipulating objects on the screen. Most of the actions on the trackball use the left button. These actions include selecting commands or options from a menu. Several options are available when using the trackball:

<table>
<thead>
<tr>
<th>Trackball Action</th>
<th>Using the trackball</th>
<th>The action is used to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Click</td>
<td>Press and release the trackball button once.</td>
<td>Select items in a list, activate buttons, select menu commands, and choose options.</td>
</tr>
<tr>
<td>Double-click</td>
<td>Press the trackball button twice in quick succession.</td>
<td>Select an item and start the action associated with the item.</td>
</tr>
<tr>
<td>Drag</td>
<td>Move the trackball so that the cursor moves over a screen object. Press the appropriate button and hold it down while continuing to move the trackball.</td>
<td>Select an option from a menu, view information not currently in a list box or window (scroll), change the width of a column.</td>
</tr>
</tbody>
</table>
3.4 USING MENUS

The Tencor FLX-2320 application uses menus from which you select the option you wish to perform next. Menu options you select can in turn display submenus, or they can display windows that contain a number of screen objects and controls.

Menus have a title bar at the top that tells you which function or menu option is displayed by them. Below the title bar is a single vertical column of menu options. The menu options represent the commands that you can perform. To perform a menu action, use the trackball to move the cursor until it rests on the desired menu option. Click the appropriate button on the trackball. The menu item is highlighted and the action is performed.

![Menu Bar](image)

Menu Bar

**Figure 3-3 Menu Structure**

3.4.1 OPENING AND CLOSING A MENU

You can open a menu and choose an action by using the keyboard or the trackball.

**Using the trackball**

Using the pointer, point to the name of the menu item on the menu bar, and click the button to open the menu. To move directly to a menu item, first press the button and drag the selection cursor down the menu until the menu item is highlighted, and then release the button.

**Using the keyboard**

Press ALT or F10 to select the menu bar. Press the left arrow or right arrow key to select the menu item you want. Press ENTER to open the selected menu item.

3.4.2 SELECTING A MENU ITEM

To choose a menu item:

Open the menu, then, do any of the following:

- Using the trackball, move the pointer to a menu item and click the button.
- Use [↑] or [↓] to select the menu item, then press ENTER.
3.4.3 MENU CONVENTIONS

The following conventions apply when using menus and menu items:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimmed item</td>
<td>The menu item is not available at this time or is not installed. The menu title or menu item is shown in gray and cannot be selected.</td>
</tr>
<tr>
<td>Ellipsis …</td>
<td>Produces a dialog box requesting additional information before executing the command.</td>
</tr>
<tr>
<td>Check mark ✓</td>
<td>The action associated with the command is currently active.</td>
</tr>
<tr>
<td>Underlined</td>
<td>For quick access to a menu item, open the menu and then press the underlined key.</td>
</tr>
<tr>
<td>Exclamation point!</td>
<td>Menu titles ending with an exclamation point immediately start the described action without displaying a pull-down menu.</td>
</tr>
<tr>
<td>Key Combination</td>
<td>A key combination on a menu indicates a shortcut for using the command. For example, in Plot3D, CTRL+N brings up the Create New Deflection dialog box. These key combinations are specified in the menus.</td>
</tr>
<tr>
<td>Right Arrow</td>
<td>The menu item opens a submenu that provides further choices.</td>
</tr>
</tbody>
</table>

3.5 WORKING WITH DIALOG BOXES

The Tencor FLX-2320 application displays dialog boxes when additional information about the action you are performing is required. For example, when the Data Editor window is activated, a Files Open dialog box appears to request additional information. You enter the Data Editor window by providing the necessary information.

When a menu item is followed by an ellipsis (…), a dialog box appears when you choose the item.

The Tencor FLX-2320 application also uses windows to display warnings, error messages, online help, and confirmation messages.

When a window or dialog box appears, you need to select options to supply information requested by the application. The active option is highlighted or marked with a dotted rectangle or both.

To select options:

1. Press TAB to move to the next option group, or press SHIFT+TAB to move to the previous option group. Groups can contain one option or several options. A rectangular box usually encloses the group and the title identifies the options.

2. Within a group of options, use the arrow keys to move from one option to another.
3.5.1 TEXT BOXES

A text box is a rectangle containing an area for entering data. When you select a text box, a flashing vertical bar called the insertion point appears. The text or values you type begin at the insertion point. As you type, the insertion point marks the next character location.

![Image of a text box]

**Figure 3-4** Text Box

If data already exists in the text box, all the text in the box is highlighted when you select the box. If you type, the text you type replaces the older text.

To edit the existing text, press [←] once to remove the highlighting. Use the arrow keys to move the insertion point and edit characters as desired. You can use [←] to erase characters to the left.

3.5.2 LIST BOXES

List boxes provide lists of options. A list offers selections within a panel or window. A list allows you to choose from a set of mutually exclusive options presented as a vertical list. A common use of lists is the display of files, charts, or tables. When the list is longer than will fit in the list box, scroll bars are provided. See Section 3.6, “Using Scroll Bars.”

![Image of a list box]

**Figure 3-5** List Box
Most list boxes prevent you from selecting more than one item at a time; however, some list boxes offer an option for selecting multiple items in a list.

To select a single item:
1. Highlight the item by clicking on it.
2. Press ENTER.

### 3.5.3 DROP-DOWN LISTS
Drop-down lists display the current setting in the text box and display other choices when you click the drop-down button.

![Drop-Down Button and List](image)

**Figure 3-6 Drop-Down Button and List**

To display a drop-down list and choose an item:
1. Click the drop-down button.
   Or use TAB to choose the drop-down list and then use [↑] and [↓] to choose an item in a drop-down list. The drop-down list does not open but the choices are displayed, one at a time, in the drop-down list box.
2. Click on an item in the list or use [↑] and [↓] to highlight the item and then press ENTER.
3.5.4 COMMAND BUTTONS

Command buttons immediately perform an action. One command button (usually OK) performs the primary action of the dialog box. Other buttons are provided for canceling the action or performing other related actions. The current or active button is surrounded by a dark border and a dotted rectangle around the name. Choose the active button by pressing ENTER. You can close a dialog box without carrying out a command by choosing Cancel.

![Diagram of dialog box with buttons labeled: Performs the primary action, Cancels the action, Performs an auxiliary action.]

Figure 3-7 Command Buttons

To select a command button:

- Click the command button or press TAB or SHIFT + TAB to select the button, then press ENTER.
- Press ESC to select Cancel.
- If available, use a shortcut key combination by pressing and holding ALT and the character underlined in the command button name. (Not all dialog boxes provide shortcuts to command buttons.)
3.5.5 OPTION BUTTONS

Option buttons are displayed in groups. Only one item in a group can be selected at one time. To change a selection within the group, choose a different button. The selected button contains a black dot. Dimmed buttons are inactive.

![Option Buttons](image)

Figure 3-8 Option Buttons

To select an option button:

Click the option button or press TAB to highlight the option group, then use the arrow keys to select the option within the group. The black dot appears when the option is selected.
3.6 USING SCROLL BARS

Scroll bars allow you to scroll through a section of text too large to be displayed entirely within a window.

Figure 3-9 Scroll Bar

To scroll using the scroll bar:

Several scrolling options are available when using the trackball:

To scroll  Do this
One line       Click one of the scroll arrows.
One window     Click the scroll bar.
Continuously   Press and hold down the trackball button while over a scroll arrow. When the desired information appears, release the button.

To any position Drag the scroll box along the scroll bar to the desired position.
The length of the scroll bar is proportional to the amount of information in the list. For example, dragging the scroll box to the middle of the scroll bar views the middle of the list.

To scroll using the arrow keys:

The information automatically scrolls when you use the page up [↑] or page down [↓] keys. (Not all windows and dialog boxes provide scrolling using arrow keys.)
3.7 WORKING WITH SYSTEM MESSAGES

Messages that appear on the screen can come from the instrument or from the Microsoft Windows system.

![Print Manager window]

The Print Manager cannot write to LPT1. There may be a
printer problem;
resume the queue when the problem is corrected or cancel the
document.

Figure 3-10 Example of a System Message

The Tencor FLX-2320 application displays a message box if

- The action you are attempting cannot be performed
- You need to acknowledge the completion of an action, confirm execution of a command, or become aware of an urgent condition

A message box contains a message and can contain corrective action for problems. For example, before deleting files using the File Manager, the Confirm Delete message box appears. Choose OK to confirm the deletion or Cancel to abort.

Some message boxes also include a Retry button that allows you to attempt to correct a problem before trying the action again.

3.8 WORKING WITH DATA DISPLAY WINDOWS

Multiple Data Display windows containing different data for the same wafer or multiple wafers can be displayed at the same time. Any number of Data Display windows can be tiled or overlapped and cascaded across the screen. For example, you can view multiple graphs in the same window.

Windows can be minimized to icons to free space on the screen and can be maximized later when you need to see the data contained in the window. For example, you can minimize one set of graphs to display a larger edit window. And if you later need to refer back to the graphs, you can double-click on the appropriate icons to redisplay (maximize) the windows. This section provides examples of managing multiple data windows.
3.8.1 SELECTING DATA DISPLAY WINDOWS

To select a window do one of the following:

- Click anywhere in the window workspace. The title bar and border of the window are highlighted when selected. If the window you want to select is concealed under other windows, move the other windows until the desired window appears, or
- Select the window from the Window menu.

3.8.2 MINIMIZING A DATA DISPLAY WINDOW
Data Display windows can be minimized when you need more screen space but still need the data in the window. When a window is minimized, a small icon representing the window is displayed at the bottom of the screen.

To minimize a window:

Choose Minimize from the window’s Control-menu box or click on the minimize button in the upper-right corner of the window. The minimize button is the small rectangle with the arrow head facing downward.

See Section 3.2, “Using Application Windows,” for more information on the system menu.

3.8.3 MAXIMIZING A DATA DISPLAY WINDOW
A Data Display window can be enlarged to its maximum size.

To maximize a window:

Choose Maximize from the window’s Control-menu box or click on the small box containing an up arrow at the right of the title bar. Trackball users can click the maximize button to enlarge a window to its maximum size. To restore to its previous size, refer to Section 3.8.4, “Restoring an Icon or Window to its Previous Size.”

3.8.4 RESTORING AN ICON OR WINDOW TO ITS PREVIOUS SIZE
A minimized window (icon) can be restored to redisplay the window at its previous location and size.

To restore a window:

With the trackball, double-click on the icon to redisplay the window at its previous location and size, or on the keyboard press ALT+SPACEBAR. This opens the Control menu. Choose Restore from the Control menu.
3.8.5 MOVING DATA DISPLAY WINDOWS
You can move Data Display windows to other screen locations.

To move a data window:
Select the window’s title bar and drag the window to the new location.

3.8.6 RESIZING DATA DISPLAY WINDOWS
You can enlarge or reduce the Data Display windows. The pointer transforms into a double-sided arrow when placed over window borders and corners. The arrow heads point in the directions you can change the window’s size.

To resize a window:
Move the pointer over the desired window border or corner. When the double-sided arrow appears, press and hold the trackball button and move the border. Release the trackball button to change the window size. You can repeat this operation for any side or corner of the window.

3.8.7 CLOSING DATA DISPLAY WINDOWS
You can close all the data display windows or selected windows.

To close all windows:
Choose Close All from the Window menu. All maximized windows and minimized windows (icons) will be closed. This command is available in the Plot3D menu.

To close an open window:
Choose Close from the File menu.

To close a minimized window (icon):
Click on the icon to display the system menu for the window and choose Close.

3.8.8 USING THE ACTIVE WINDOW
It is important to understand the concept of the active window. The currently selected window is highlighted to signify that it is the active window. The options selected from the Data Display menus and any status information displayed on the screen are always associated with the active window. If you minimize a window or select a different window, the menus are updated and display the data display options for the active window.

Note that you can check the options selected for a minimized window by selecting the applicable icon before displaying a menu. Afterward, the menu displays the option settings for the minimized window. You can add the same display settings used on a minimized window to the active window by temporarily selecting the minimized icon and displaying the menu options selected.
3.9 STARTING THE INSTRUMENT

Use the following procedure to start the instrument and select options.

**CAUTION:** We strongly recommend that you read the section on Operating Safety on page v before starting the instrument.

To start the instrument:

1. Make sure the electrical power cords and necessary cables are connected to the instrument and the computer. See Section 2.4.2, “Installing the Instrument,” for details.

2. Turn the computer on. The computer automatically loads the software and displays the user login dialog box and the Tencor FLX-2320 Main menu:

![Tencor FLX-2320 Main Menu](image)

**Figure 3-11 Tencor FLX-2320 Main Menu**

3. Choose submenus by using the trackball. To display the options in a submenu, select the submenu and press ENTER. See Section 3.10, “Main Menu, Submenus, and Submenu Options,” for a schematic representation of the submenus and their options.

3.10 MAIN MENU, SUBMENUS, AND SUBMENU OPTIONS

If you do not have the SECS Interface Option, the Main menu (Fig. 3-12) consists of four submenus. If your instrument has the SECS Interface Option installed, an additional submenu—Host—is added to the Main menu list. The first four menus—Measure, Utilities, Edit, and Analysis—list options for instrument operation. The next two submenus—View and Help—are informational.

Figure 3-12 delineates the Main menu, submenus, and their options. Submenu options are explained as they appear in the manual.
Figure 3-12 Main Menu, Submenus, and Options
states or to transfer and receive process programs and terminal messages with the host. For detailed information on initiating and stopping measurements from the host computer, message listings and their details, and SECS scenarios, refer to the Tencor FLX SECS Interface Manual.

NOTE: If your instrument has the SECS Interface option installed, an additional submenu titled Host is available on the Main Menu window. The SECS control state — Local or Remote—is also displayed in the upper right of the window.

3.12.1 COMMUNICATION AND CONTROL STATES
The current communication and control states are displayed in a box located at the upper-right corner of the screen.

The communication state is indicated by the color of the box. White indicates disabled, red indicates enabled/not communicating, and green indicates enabled/communicating.

The control state is displayed as text in this box. The possible conditions are Equip. Offline, Attempt Offline, Host Offline, Online/Local, and Online/Remote. In addition to the control state, two other text indicators may proceed the control state text. They are

- "*: Spooling is active
- "TTY": At least one terminal message from the Host is currently being buffered.

The switch for the Online substate is located in the Host submenu (Fig. 3-15). A check mark is located next to the currently set Online substate. The substates are either Local or Remote. Note that in order to perform remote commands from the host, the Remote substate must be selected, and to perform operations from the equipment, the Local substate must be selected.

![Figure 3-15 SECS Parameters Dialog Box](image)

The switches for Equipment offline/online are also located in the Host submenu. They are indicated by the words "Go Offline" and "Attempt Online." Select the appropriate menu item to switch between the online and offline control states.
3.12.2 SETTING THE SECS PARAMETERS

Once you have set the SECS parameters, these settings become the default settings.

To set the SECS parameters:

1. Choose Config from the Host menu. The SECS parameters dialog box displays.

![SECS Parameters Dialog Box](image)

Figure 3-16 SECS Parameters Dialog Box

2. Enter values for the fields using the following list. After entering a value in a field, press TAB to move to the next field.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Init Comm State</td>
<td>The software reverts to this default state when the software is restarted. Available modes from the drop-down menu are Enabled and Disabled.</td>
</tr>
<tr>
<td>Poll Delay</td>
<td>Poll Delay is the interval, in seconds, at which the instrument checks for communication from the host computer and updates the communication window accordingly.</td>
</tr>
<tr>
<td>Estab. Comm. Delay</td>
<td>The setting in this field determines at what time interval, in seconds, a failed connect request is retried.</td>
</tr>
<tr>
<td>Spooling Enabled</td>
<td>Select this box to enable the spooling function. Unselecting this box disables spooling. WARNING: Disabling the spool places the equipment in a non-GEM compliant operating mode.</td>
</tr>
<tr>
<td>Overwrite Spool</td>
<td>Select this box if you wish to overwrite the existing spool.</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Max. Spool Transmit.</td>
<td>Determines how many messages the equipment sends to the host in response to an S6F23 “Transmit Spooled Messages” request.</td>
</tr>
<tr>
<td>Max Spool File Size</td>
<td>The maximum size of the spool area.</td>
</tr>
<tr>
<td>Model (MDLN):</td>
<td>The name of the specific Tencor Flexus model.</td>
</tr>
<tr>
<td>Rev.</td>
<td>The revision level of the software for the Tencor FLX product.</td>
</tr>
<tr>
<td>Device Name</td>
<td>The Tencor FLX product line name.</td>
</tr>
<tr>
<td>Init Control State</td>
<td>The software reverts to this default state when the software is restarted. Available modes are Online and Offline.</td>
</tr>
<tr>
<td>Online Failed State</td>
<td>The software reverts to this default offline state when an attempt to go Online fails.</td>
</tr>
<tr>
<td>Annotated Reports (S6F13)</td>
<td>Click on this box to generate annotated reports.</td>
</tr>
<tr>
<td>W-Bit for S6</td>
<td>Click on this box to enable the reply bit on Stream 6 messages transmitted from the equipment.</td>
</tr>
<tr>
<td>W-Bit for S5</td>
<td>Click on this box to activate the alarm for W-bit for S5.</td>
</tr>
<tr>
<td>W-Bit for S10</td>
<td>Enables W-bit for Stream 10 terminal messages.</td>
</tr>
<tr>
<td>Buffer TTY Msgs</td>
<td>If checked, terminal messages from host will not be displayed immediately, but instead buffered for later viewing.</td>
</tr>
</tbody>
</table>

3. After completing the dialog box, choose OK to accept the values or choose CANCEL to start again.
3.12.3 UPLOADING AND DOWNLOADING PROCESS PROGRAMS
Use the procedures in this section to upload and download process programs to and from the host computer.

To upload a process program to the host:

1. Choose Upload from the Process Programs menu (Fig. 3-17). A Process Program Upload dialog box displays.

   ![Process Program Menu](image)

   Figure 3-17 Process Program Menu

2. Enter the name of the desired file and choose Upload. A message is displayed after the file has been successfully transferred telling you that the upload is complete.

To download a process program from the host:


2. Enter the name of the desired file and choose Download to start the transfer process. A message is displayed after the file has been successfully transferred telling you that the download is complete.

   **NOTE:** An existing file cannot be downloaded if it is currently executing or being edited.

3.12.4 TERMINAL MESSAGES

To send a terminal message

To send a terminal message to the host computer, bring up the dialog box shown in Figure 3-17. Enter the message and press OK.

![SECS Parameters Dialog Box](image)

Figure 3-18 SECS Parameters Dialog Box
To receive and acknowledge a message

If the Host computer sends a terminal message to the Tencor FLX system, a view and acknowledge dialog box similar to the following displays.

![View and Ack-Try Msg from Host Dialog Box](image)

Figure 3-19 View and Acknowledge Dialog Box

Press ACK HOST MSG to acknowledge the message and press OK to close the box. If you selected to buffer TTY messages as described in the section, Setting the SECS Parameters, then the box does not automatically appear. Instead, the Control state text located in the upper right of the screen will be preceded by the text “(TTY)”. In this case, point the mouse inside the region of the Communication state rectangle. Press View and ACK Host TTY Msg. Then continue as described above.

### 3.13 SHUTTING DOWN THE INSTRUMENT

When turning off the instrument, use the following procedure to ensure against loss of data.

**To shut down the instrument:**

1. Close all open windows and choose Exit from the Measure menu.
2. Choose Exit from the Program Manager File menu.
3. At the DOS prompt, turn off the power to the computer.
4. Turn off the instrument power. For the location of the instrument Main On/Off power switch, see Figure 3-1.
4 PERFORMING MEASUREMENTS

This chapter describes how to perform stress measurements (first, single, stress-time, and stress-temperature).

The procedures in this chapter assume a knowledge of instrument controls and basic operations such as starting and shutting down the instrument. These operations are described in Chapter 3, "Basic Skills." If you have not already done so, read Chapter 3 before proceeding.

4.1 STRESS MEASUREMENTS

Stress measurements involve setting up a process program, taking a measurement of the undeposited wafer, and finally a measurement of the deposited wafer. The Tencor FLX-2320 instrument also provides the option of taking stress measurements at specified intervals over a specified length of time and taking stress measurements as a function of temperature. All these measurement options are described in the following sections.

4.1.1 SETTING UP THE PROCESS PROGRAM

Before starting stress measurements, you can set up the process program or select a previously created program. The process program specifies parameters such as the number of scan points, the directory in which the data file is saved, the elastic modulus, the substrate thickness, and the wafer diameter. Note: You do not need to select or set up the process program before each measurement.

To select or set up the process program:

1. From the Edit menu, choose Process Programs.
   
   The Process Program dialog box displays with the name of the process program displayed in the title bar.
2. To load another process program, choose the Load button to display a list of available process programs.

3. Use [↑] or [↓] to scroll through the list. Select the desired process program and press ENTER. The system loads the process program and displays the process program name in the title bar of the Process Program window. Proceed to step 4 to edit the process program or choose Save to save the process program and exit the window and proceed to the sections on measuring wafers.

4. In the Process Program dialog box, select the desired parameters. To edit the parameter, type another value. For parameters that have predefined values, use [←] or [→] to select values. Use the following list as a guide to selecting and entering
values for the parameters. After entering a value, press ENTER to move the cursor to the next field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Scan Points</td>
<td>You can specify up to a maximum of 1250 points per scan; 50 points per scan are sufficient for a correct measurement. Also note that when scan profiles are saved, only 50 data points are saved with each scan to conserve space on the hard disk.</td>
</tr>
<tr>
<td>Low Intensity Alarm</td>
<td>Specify an intensity limit below which measurement points will be ignored. If set, this alarm will also sound if a measurement is started without a wafer in the instrument or with a poorly reflecting substrate.</td>
</tr>
<tr>
<td>Elastic Modulus</td>
<td>The biaxial elastic modulus of the substrate to be used in the stress calculations.</td>
</tr>
<tr>
<td>Substrate Thickness</td>
<td>The thickness of the substrate in microns.</td>
</tr>
<tr>
<td>Wafer Diameter</td>
<td>The diameter of the wafer in millimeters.</td>
</tr>
<tr>
<td>Save Scan</td>
<td>This is a toggle. If this value is set to No, choose the Save Scan button to set to Yes. Note: The software saves only 50 data points in the scan file irrespective of the number of scan points specified in the Maximum Scan Points field.</td>
</tr>
<tr>
<td>Auto Scan</td>
<td>Set Auto Scan to On to scan from 10% to 90% of the substrate diameter. To define desired scan limits, set Auto Scan to Off. You are prompted to enter the starting (From) and ending (To) scan positions (in mm) after the last field, Wafer Type, is edited.</td>
</tr>
<tr>
<td>Hole Diameter</td>
<td>The diameter of the center region of the substrate to be skipped. (This feature is used for hard or compact disk applications.)</td>
</tr>
<tr>
<td>Units</td>
<td>Select Units to select MPa or dynes/cm² units.</td>
</tr>
<tr>
<td>Laser Selection</td>
<td>Use the drop-down list to select Automatic, 670 nm, or 750 nm.</td>
</tr>
</tbody>
</table>

5. Choose Save to save the changes to the process program, Cancel to not save the changes, or Load to load another process program, without saving the current values.
4.1.2 FIRST STRESS MEASUREMENT

Use the First Stress Measurement mode to measure the stress on wafers before deposition.

To measure the stress on wafers before deposition:

1. Install the wafer locator ring on the hot plate measurement platform and place the blank wafer, face up, in the ring. For details on using locator rings, see Section 3.11, "Using Wafer Locator Rings." Note: Do not replace the hot plate cover for room temperature measurements.

2. Choose First (No Film) from the Measure menu. The First Stress Measurement dialog box displays.

![First Stress Measurement Dialog Box](image)

Figure 4-3. First Stress Measurement Dialog Box

All fields except Elastic Modulus, Wafer Diameter, and Auto Scan can be edited. The data in these fields is supplied by the selected process program and cannot be edited in this dialog box.

**NOTE:** After entering the filename, path, and ID (steps 4 and 5), you can start the measurement by choosing the Measure button. Entering data in the remaining fields is optional.

3. In the File field, enter the path and filename (eight characters maximum) to save the data points. (Note: You do not need to specify a file extension; the software assigns the extension .DAT automatically.) To save the data in a previously existing file, choose the Files button to display a list of existing filenames. Select the desired filename.

4. In the ID field, enter an ID (16 characters maximum) or select the desired ID from the drop-down menu.

5. In the Orientation field, enter the orientation of the wafer and how many degrees of rotation.
6. In the Comment field, type a comment (12 characters maximum).
7. Enter the thickness of the substrate in microns.
8. To start the measurement without selecting another process program, choose the Measure button (Fig. 4-3). To select another process program, select Process Program from the Edit menu. The software displays a list of available process programs. Select the desired process program and press ENTER.

Viewing a graph

After the measurement is complete, the instrument displays the substrate deflection and the light intensity graphs, and a graph menu bar. The graph menu options display only when a graph is active. Figure 4-4 is a sample scan profile showing the substrate deflection and the graph menu bar.

![Graph Menu Bar](image)

![Scan Profile](image)

Figure 4-4 Sample Scan Profile and Graph Menu Bar
Figure 4-5 is a sample light intensity graph.

![Graph Image]

Figure 4-5 Displaying the Light Intensity

A negative radius, on the Deflection graph, indicates a convex surface and a positive radius indicates a concave surface.

To save a graph to a data file:

1. Choose Save As from the File menu. The Save As dialog box displays:

![Save As Dialog Box]

Figure 4-6 Saving the Graph Information

2. Enter the name for the graph and choose OK. Note that if you measure the sample again using the same ID, a second record is created and saved without overwriting the first record. The most recent record is used as the valid record when measuring stress after deposition.
Using the Graph menus

Whenever a graph displays and is active, a set of graph menu options displays. These menu options allow you to change the font of the graph text; change the shape and color of the graph points; resize and reposition the graph; reorder the curve shape; reduce or eliminate noise in the graph; and specify the colors for the graph attributes.

4.1.3 SINGLE STRESS MEASUREMENT

Use the Single Stress Measurement mode to measure stress on wafers after deposition.

To measure the stress after deposition:

1. Install the wafer locator ring on the hot plate measurement platform and place the wafer, face up, in the ring. For details on using locator rings, see Section 3.11 “Using Locator Rings.” Note: Do not replace the hot plate cover for room temperature measurements.

2. Choose Single from the Measure menu. The Single Stress dialog box appears, as shown in Figure 4-7.

![Figure 4-7 Single Stress Dialog Box](image)

All the fields displayed in the Single Stress dialog box can be edited; entering information in the Comment field is optional.

3. Enter the same filename and path as entered in the first stress measurement, in the File field. If you cannot recall the filename, choose the Files button to display a file selection dialog box. Choose the desired filename from the list of filenames. Press TAB to move the cursor to the ID field.

4. Enter the same ID as entered in the first stress measurement. If you cannot recall the ID, click on the drop-down arrow to display a list of IDs for the selected file. Choose the desired ID. Press TAB to move the cursor to the Comment field.

5. In the Orientation field, enter the orientation of the wafer and how many degrees of rotation.
6. In the Comment field, press TAB to not enter a comment, or type a comment (12 characters maximum) and press TAB. The cursor moves to the Film Thickness field.

7. In the Film Thickness field, enter the thickness of the film, in Angstroms, and choose Measure. Note: If the film was etched rather than deposited, enter the film thickness as a negative value (enter a minus sign [−] before the value).

8. Choose Measure to start the measurement. After the measurement is complete, the instrument displays both the substrate deflection and the light intensity in graphs similar to Figures 4-4 and 4-5.

The measured radius and stress values are displayed on the graphs. A negative value indicates compressive stress and a positive value indicates a tensile stress. A negative radius indicates a convex surface; a positive radius indicates a concave surface when viewing the wafer from the polished side.

To analyze the data using the Data Editor window or Data Analysis options, see Sections 5.1, “Working with Data Files,” and Chapter 7, “Data Analysis,” for details.

4.1.4 STRESS-TIME MEASUREMENT

Use the Stress-Time Measurement mode to measure the stress, over a specified period of time, on a wafer after deposition. The stress-time measurement reveals kinetics such as water absorption in oxides, densification, phase transformations, and stress relaxation. Note that the total number of records in a data file is limited to 1000.

To measure the film stress on a deposited wafer using the Stress-Time mode:

1. Install the wafer locator ring on the hot plate measurement platform and place the wafer, face up, in the ring. For details on using locator rings, see Section 3.11 “Using Locator Rings.” Note: Do not replace the hot plate cover for room temperature measurements.
2. Choose Time from the Measure menu. The Stress-Time dialog box appears, as shown in Figure 4-8. All the fields displayed in the Stress-Time dialog box can be edited; entering information in the Comment field is optional.

![Stress-Time Dialog Box](image)

Figure 4-8 Stress-Time Dialog Box

3. Enter the same filename and path as entered in the First Measurement mode, in the File field. If you cannot recall the filename, choose the Files button to display a file selection dialog box. Choose the desired filename from the list of filenames. Press TAB to move the cursor to the ID field.

4. Enter the same ID as entered in the first stress measurement. If you cannot recall the ID, press the drop-down arrow to display a list of IDs for the selected file. Choose the desired ID. Press TAB to move the cursor to the Comment field.

5. In the Orientation field, enter the orientation of the wafer and how many degrees of rotation.

6. In the Comment field, press TAB if you do not want to type a comment, or type a comment (12 characters maximum), then press TAB. The cursor moves to the Film Thickness field.

7. In the Film Thickness field, enter the thickness of the film, in Angstroms. Note: If the film was etched rather than deposited, enter the film thickness as a negative value (enter a minus sign [-] before the value).

8. In the Interval field, enter the time interval the wafer will be measured, in minutes and seconds. Press TAB to move the cursor to the Total Time field.

9. Enter the total time, in minutes and hours, for which the wafer will stay in the measurement chamber and be measured. Press ENTER or choose Measure to start the measurements. The instrument measures the stress on the wafer at the specified time intervals for the total time specified. Note: A maximum of 1000 measurements are allowed per data file.
A stress-time graph similar to the following displays as the measurements are being taken showing various time values, and after the measurements are complete.

![Stress-Time Graph](image)

**Figure 4-9  Sample Stress-Time Graph**

10. Close the graph windows. Repeat steps 1 through 8 to take another set of measurements. To exit the Stress-Time measurement option, double-click on the Control-menu box.

To display and analyze the saved data, use the instructions in Section 5.1, “Working with Data Files,” and Chapter 7, “Data Analysis.”

### 4.1.5 STRESS-TEMPERATURE MEASUREMENT

Use the Stress-Temperature Measurement mode to measure the stress as a function of temperature on a wafer after deposition. The instrument uses temperature cycling to reveal stress changes. Temperature cycling causes stress changes due to thermal expansion, mismatch, volume changes, and plastic deformations.

**To measure the stress on a deposited wafer using the Stress-Temperature mode:**

1. Install the wafer locator ring on the hot plate measurement platform and place the wafer, face up, in the ring. For details on using locator rings, see Section 3.11 “Using Locator Rings.” Note: Do not replace the hot plate cover for room temperature measurements. Replace the hot plate cover and tighten the thumbscrews. Close the instrument door.
2. Choose Temperature from the Measure menu. The Stress-Temperature dialog box appears, as shown in Figure 4-10.

![Figure 4-10 Stress-Temperature Dialog Box](image)

All the fields displayed in the Stress-Temperature dialog box can be edited; entering information in the Comment field is optional.

3. Enter the path and filename (the software assigns the extension .DAT automatically) in the File field, to save the data points. To save the data in a previously existing file, choose the Data Files button, a file selection dialog box displays. Choose the desired filename from the list. The cursor moves to the ID field.

4. In the ID field, enter an ID (eight characters maximum) and press TAB. The cursor moves to the Comment field.

5. In the Orientation field, enter the orientation of the wafer and how many degrees of rotation.

6. In the Comment field, press TAB to not enter a comment, or type a comment (12 characters maximum) and press TAB. The cursor moves to the Film Thickness field.

7. In the Film Thickness field, enter the film thickness in Angstroms and press TAB.

Recipes

A recipe contains data that the instrument uses to automatically take a temperature measurement. The information in a recipe determines the settings of a Stress-Temperature measurement, the target temperature, the number of readings during a temperature ramp, and time and ramp rate. To run a Stress-Temperature measurement, a recipe must exist. In the Stress-Temperature mode, you can use an existing recipe or create a new recipe.
To perform a temperature measurement using an existing recipe:

1. To use an existing recipe, choose the Open Recipe button in the Stress-Temperature dialog box (Fig. 4-10).
2. A dialog box displays with a list of existing recipe files.

![File List of Recipes](image)

**Figure 4-11** File List of Recipes

3. Choose the desired recipe file and choose OK. The Stress-Temperature dialog box redisplays with the selected recipe.
4. Choose the Measure button (Fig. 4-10) to perform the temperature measurement with the selected recipe.

To create a new recipe:

1. Display the Stress-Temperature Measurement dialog box.

![Creating a Recipe](image)

**Figure 4-12** Creating a Recipe

2. Select a line for entering the heating and cooling cycles in the Recipe menu area.
3. Enter the desired target temperature, time, and number of readings. After entering a value in each field, press TAB to move to the next field. Note: You can skip entering
the time and enter the Ramp value only. The software will automatically calculate the Time using the Ramp value.

4. To automatically calculate and display the Ramp value, in degrees Celsius per minute, select the time option as the priority after entering a value in the Readings field. If values are entered in both the Time and Ramp fields, the value in the Time field takes precedence.

NOTE: In some cases the stage cooling could be smaller than the requested ramp (especially at low temperatures). To get around this, set up two recipe lines with the same temperature.

5. Select the next recipe line and enter values. You can enter a maximum of 150 recipe lines and the total number of readings should not exceed 1000.

6. Choose the Save Recipe button (Fig. 4-12). The Save As dialog box displays.

![Image of Save As dialog box]

Figure 4-13 Saving a Recipe

7. Enter the desired filename for the newly created recipe. Choose OK.

After saving the recipe, you can perform a Stress-Temperature measurement.

To perform a temperature measurement using the newly created recipe:

1. Once the recipe is created, choose the Measure button to perform the temperature measurement with the selected recipe.

As the measurements are done and data is collected, a Stress-Temperature graph is displayed on the monitor. Figure 4-14 is a sample Stress-Temperature graph.
Figure 4-14 Sample Stress-Temperature Graph

2. Close the graph windows. After the measurements are complete, you can display and analyze the saved data using the instructions in Section 5.1, “Working with Data Files,” and Chapter 7, “Data Analysis.”

**WARNING:** The stage heats up to 500° C while operating. DO NOT open the furnace or attempt to remove the wafer until the stage has cooled.

3. To remove the wafer, wait until the heater has cooled. Then, remove the heater cover and remove the wafer. To measure stress on another wafer using the Stress-Temperature mode, place the new wafer, on the heater and repeat the previous steps in Section 4.1.5, “Stress-Temperature Measurement.”
5 MANAGING DATA FILES

This chapter describes how to

- Manage files using the delete, copy, and rename functions
- Display data files
- Copy, save, delete and rename data records
- Export, merge and print data files
- Edit data records

The procedures in this chapter assume a knowledge of instrument controls and basic operations such as starting and shutting down the instrument. These operations are described in Chapter 3, "Basic Skills." If you have not already done so, read Chapter 3 before proceeding.

5.1 WORKING WITH DATA FILES

Once measurements have been taken, you can display the saved data file (extension .DAT) to alter, delete, or merge records, and plot graphs or trends. The procedures in this section describe how to display and work with data files.

5.2 USING FILE MENU OPTIONS IN THE EDITOR WINDOW

You can load, rename, save, merge, and print a data file.

5.2.1 DISPLAYING ADDITIONAL DATA FILES

To display another file:

1. To display another file, choose Load from the File menu.
2. Enter the filename and press ENTER. The file is loaded into the Data Editor window.

5.2.2 SAVING DATA FILES
You can save a data file under its current name or a different name.

To save a data file:

2. Edit the data file as desired. See Section 5.3.1, “Editing Records,” for details.
3. To save the data file with the current name, choose Save from the File menu.
4. To save the data file with a new name, choose Save As. A dialog box displays prompting you to enter a filename. Enter the new filename and press ENTER to save the data file under the new filename.
5.2.3 RENAMING A FILE
Use the procedures in this section to rename files in the Data Editor window.

To rename a file:

1. In the Data Editor window, open the file to be renamed.
2. Choose Save As from the File menu. The Save As dialog box displays:

![Save As Dialog Box](image)

3. Enter a new filename and press ENTER. To change the directory, enter the path and directory name (end with a backslash [\]) and press ENTER.

5.2.4 MERGING DATA FILES
Note: Data files can have up to a maximum of 1000 records.

To merge two data files:

1. Display the data file into which you want to merge data from another file. See Section 5.1, "Working with Data Files," for details.
2. Move the cursor to the record after which the records are to be added.
3. Choose Merge from the File menu and press ENTER. The software prompts you to enter a filename. Enter the filename and press ENTER. The file is loaded into the file displayed in the Data Editor window at the point of the cursor.

5.2.5 PRINTING DATA FILES
The printer must be connected to the FLX-2320 and be online to print data files. Note: To print blocks of records, see Section 5.3.1, "Editing Records," for more details.

To print a data file:

2. Choose Print from the File menu and press ENTER.
5.2.6 PRINTING RECORDS

To print records:

1. Select the block of records using the instructions in Section 5.3.2, "Selecting Records."

2. Choose Print from the File menu. The Print dialog box displays:

![Print Dialog Box](image)

Figure 5-3 Print Dialog Box

3. Choose OK to send the print job to the designated printer.

5.2.7 CLOSING A DATA FILE

Close a data file by choosing Close from the File menu. The active open window closes.

5.3 EDIT MENU OPTIONS

Use the edit menu options to select and unselect blocks of files, move, copy, delete, recalculate stress and create no film records.

To display a data file:

1. From the Editor menu, choose Edit.
2. From the Edit menu, choose Data Files. A dialog box displays prompting for the desired filename.

![Data Files Dialog Box](image)

**Figure 5-4 Entering a Data Filename**

3. Choose OK to accept the default data filename, or enter the desired filename and choose OK. To change the directory name, enter the path and directory name (end with a backslash [\]) and press ENTER. A list of available files for the specified pathname is displayed. Select the desired filename and press ENTER. The data file, similar to the following example, is displayed in the Data Editor window.

![Data Editor Window](image)

**Figure 5-5 Data File Displayed in the Data Editor Window**

The name of the data file is displayed below the menu bar.
Moving within the Data Editor Window

The data file displays only 7 fields horizontally; to display additional information for the measurement, use any of the following key combinations to move within the Data Editor window.

CTRL+PAGE UP                     Returns to the first record
CTRL+PAGE DOWN                   Goes to the last record
TAB                                Goes to the next field
SHIFT+TAB                         Goes to the previous field
PAGE DOWN                         Displays the next page
PAGE UP                            Displays the last page
SHIFT+END                         Goes to the end of a record
SHIFT+HOME                        Goes to the beginning of a record
F7                                  Mark block start
F8                                  Mark block end
F9                                  Unmark Block

5.3.1 EDITING RECORDS

You can edit the ID, Comment, Substrate Thickness, Film Thickness, and Elastic Modulus fields for each record, and recalculate the stress using a different elastic modulus, substrate thickness, or film thickness, or a combination of all three. Edit records in the data file by using the options under the Edit menu (Fig. 5-6).
To edit the records in a data file:

- Display a data file (Fig. 5-5). See Section 5.1, "Working With Data Files," for details.

5.3.2 SELECTING RECORDS

- With the trackball button pressed down, pull the cursor arrow down the window. Notice that as you are pulling the cursor down, the records are highlighted. Pull the cursor arrow to the desired position. All selected records are highlighted. The arrow must be in the record number column.

To select and unselect a block of data:

- In the Data Editor window (Fig. 5-5), select the first record to be edited, press F7 or Mark Block Start from the Edit menu. Move the cursor to the last record to be selected, press F8 to end the block selection. The marked block is highlighted. You can move, copy, or delete the selected block of data.
- To unselect a block of data, press F9 or choose Unmark Block from the Edit menu.

5.3.3 MOVING RECORDS

To move records in a data file:

1. Select a block of records using the instructions in Section 5.3.2, "Selecting Records."
2. Choose Move from the Edit menu.
3. Move the cursor to the record before which you wish to insert the block, and double-click. The selected information is moved to that point.

5.3.4 COPYING FILES
Use the procedures in this section to copy a file to a new filename or overwrite an existing file.

To copy a file:
1. Choose Data Files from the Edit menu. You are prompted for the name of the data file. Enter the desired filename. The Data Editor window displays:

![Figure 5-7 Data Editor Window](image)

2. Select the desired records. Choose Copy from the Edit menu:

![Figure 5-8 Edit Menu](image)
3. Place the cursor where you want to copy the information. Double-click on the trackball at that spot. The selected information is copied.

5.3.5 DELETING RECORDS

Use the procedures in this section to delete records from the Data Editor window.

To delete a group of records within a file:

1. Use [↑] [↓] to select the records you want to delete.
2. Choose Delete from the Edit menu. The selected records are deleted.

5.3.6 RECALCULATING STRESS

To recalculate stress values:

1. Change the film or substrate thickness, or elastic modulus in the first record of the block. See Section 5.3.1, “Editing Records,” for details on editing records.
2. Select the block of records, starting at the edited record, using the instructions found in Section 5.3.2, “Selecting Records,” for details on selecting records.
3. Choose Recalculate Stress from the Edit menu.

Figure 5-9 Recalculating Stress

Stress values for the desired records in the selected block are automatically calculated.
5.3.7 CREATING A NO FILM RECORD
Use this menu option to create a film with no records.

To create a no film record in a data file:
Choose Create No Film Rec from the Edit menu. The Data Editor window updates the selected files with N/A in the Film Thick column.

5.4 EXPORTING DATA FILES
Data files are exported as ASCII files with the extension .TXT. If you choose to save the ASCII data in rows only, the record fields of the data file appear as 14 consecutive rows as displayed in Figure 5-9. ASCII files can be read and manipulated in other data handling software such as Lotus 1-2-3.

To export a data file:
2. Choose ASCII-Lotus from the Export menu in the Data Editor window.
3. The system prompts you to enter a filename for the ASCII data. Enter a filename and press ENTER. (Note: The extension, .TXT, is automatically added to the filename).
4. Close the window. You can recall the saved ASCII-format files in programs that manipulate data such as Lotus 1-2-3.

5.5 GRAPH MENU OPTION
Use this menu option to create, edit, and display data and to plot graphs and trends. Refer to Chapter 6, “Creating and Displaying Graphs,” for information on using this option.
6 CREATING AND DISPLAYING GRAPHS

This chapter describes the operation of the instrument. It describes how to create, edit, and display data and plot graphs and trends.

The procedures in this chapter assume a knowledge of instrument controls and basic operations such as starting and shutting down the instrument. These operations are described in Chapter 3, "Basic Skills." If you have not already done so, read Chapter 3 before proceeding.

6.1 CREATING GRAPHS

Use this option to create graphs from the raw data files. You have the option of creating a graph from the entire data file or from a selected block.

To create a graph:

1. Display a data file in the Data Editor window.
2. Choose Create from the Graph menu. The Create Graph dialog box displays:

![Create Graph Dialog Box](image)

Figure 6-1 Create Graph Dialog Box
3. Enter values for the fields using the following list. After each entry or selection, press TAB to move to the next field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Label</td>
<td>The label to be displayed above the graph. You can enter any combination of characters and numbers.</td>
</tr>
<tr>
<td>X</td>
<td>The X-axis of the graph. Choices available from the drop-down list are Time, Stress, Bow, Record Number, Temperature, and Light Intensity. If you select Time or Stress, an additional field is displayed next to the field to allow you to enter Initial Time or Stress respectively.</td>
</tr>
<tr>
<td>Y</td>
<td>The Y-axis of the graph. Choices available from the drop-down list are Stress, Bow, Record Number, Temperature, and Light Intensity. If you select Time or Stress, an additional field is displayed next to the field to allow you to enter Initial Time or Stress respectively.</td>
</tr>
<tr>
<td>Initial Stress</td>
<td>Initial time or initial stress. Initial time is entered in hours and minutes, and initial stress in MPa or dynes/cm².</td>
</tr>
<tr>
<td>Modulus Correction</td>
<td>To apply the modulus correction to the data, choose the Modulus Correction button. The dot in the center of the circle indicates that this option is activated; to not apply the Modulus Correction, choose the Modulus Correction button until the circle in the center of the button disappears. For details on this feature refer to the Film Stress Applications Note #2, “Effects of Temperature on Biaxial Elastic Modulus.”</td>
</tr>
<tr>
<td>Autoscale Axis</td>
<td>Choose the Autoscale Axis button to activate. Once Autoscale axis is selected, additional options display.</td>
</tr>
<tr>
<td>X From:</td>
<td>Starting X value.</td>
</tr>
<tr>
<td>Y From:</td>
<td>Starting Y value.</td>
</tr>
<tr>
<td>X To:</td>
<td>Ending X value.</td>
</tr>
<tr>
<td>Y To:</td>
<td>Ending Y value.</td>
</tr>
<tr>
<td>X Step:</td>
<td>Distance between grid markings on the X-axis.</td>
</tr>
<tr>
<td>Y Step:</td>
<td>Distance between grid markings on the Y-axis.</td>
</tr>
<tr>
<td>Create Graph</td>
<td>Creates a graph.</td>
</tr>
</tbody>
</table>
Cancel

Cancels the application.

4. Choose the Create Graph button, the graph for the selected file is displayed (Fig. 6-1).

5. To display a graph of only some records, select the block of records using the following procedures:
   - In the Data Editor window, move the cursor to the record that begins the block to be selected.
   - Drag the cursor to the end of the block. The record numbers in the block are highlighted, indicating the records are selected. To deselect the block, double-click anywhere in the window.
   - Choose Create Graph from the Create Graph dialog box (Fig. 6-1). Figure 6-2 is a sample graph of a selected file.

![Sample Graph](image)

Figure 6-2  Sample Graph

6. To save the graph, choose Save As or Save from the Graph menu.

6.1.1 USING THE ZOOM FEATURE

You can use the zoom feature to magnify a portion of the graph.

To zoom in a portion of a graph:

1. Move the cursor into the graph area.
2. Double click on the trackball button. The cursor changes to a movable rectangle shape.
3. Move the trackball to place the rectangle over the area you want to magnify.
4. Click to magnify the portion of the graph enclosed by the rectangle.

5. If you make a mistake, choose Restore from the File menu to return to the normal resolution.

Graph Options

You have the following options in the Graph menu:

- Use the File menu to load, save, rename, and merge graph files.
- Use the Font menu to set font styles for graph text.
- Use the Points menu to change the color and shape of graph points and to connect points.
- Use the Axis Scale menu to resize the graph.
- Use the Curve Fitting menu to fit a line or polynomial up to an order 3 to the data.
- Use the Smoothing menu to reduce or eliminate noise.
- Use the Color menu to specify colors for the different graph attributes.
- Double-click on the Control-menu box to close the Graph window and return to the Graph menu. To redisplay a graph for the same file but with different graph options, repeat steps 1, 2 and 3.

To exit the Graph Retrieval option, double-click on the Control-menu box to return to the Main menu.

6.2 CREATING A TREND PLOT

Use this option to plot trends from the raw data files. You have the option of generating a trend plot from the entire data file or from a selected block.

To generate a trend plot:

1. Display a data file in the Data Editor window:
   - Choose Trend Plot from the Graph menu in the Data Editor window.
A Trend Plot dialog box displays (Fig. 6-3).

Figure 6-3 Trend Plot Dialog Box

- Enter values for the fields using the following list. After each entry or selection, press TAB to move to the next field.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Label</td>
<td>The label to be displayed at the top of the trend plot. You can enter any combination of characters and numbers.</td>
</tr>
<tr>
<td>X</td>
<td>The X-axis of the graph. Choices available are Record Number, Date, and Days.</td>
</tr>
<tr>
<td>Y</td>
<td>The Y-axis of the graph. The X-axis is set to Stress (MPa or dynes/cm²) and cannot be changed.</td>
</tr>
<tr>
<td>Autoscale</td>
<td>Choose Autoscale to activate this feature.</td>
</tr>
<tr>
<td>Autoscale X</td>
<td>Y autoscales the X-axis; unselecting Autoscale disables the feature.</td>
</tr>
<tr>
<td>Autoscale Y</td>
<td>Y autoscales the Y-axis; unselecting Autoscale disables this feature.</td>
</tr>
<tr>
<td>Upper SL</td>
<td>The Upper Specification Limit in MPa or dynes/cm².</td>
</tr>
<tr>
<td>Lower SL</td>
<td>The Lower Specification Limit in MPa or dynes/cm².</td>
</tr>
<tr>
<td>Calculate STD deviation</td>
<td>Y calculates the standard deviation (the specification limits will not be displayed); N disables the feature (the specification limits will be displayed).</td>
</tr>
</tbody>
</table>
2. Choose Trend Plot from the Trend Plot dialog box (Fig. 6-3). A trend plot displays. Figure 6-4 is a sample plot without standard deviation being calculated.

![Sample Trend Plot]

Figure 6-4  Sample Trend Plot

3. To display a trend plot of only selected records, select a block of records using the following procedures:

   • Drag the cursor to the end of the block.
   • The selected block is highlighted. To unselect the block, double-click anywhere in the window.
   • Choose Trend Plot from the Trend Plot dialog box (Fig. 6-3).

If the option to calculate the standard deviation was not selected in the Trend Plot dialog box (Fig. 6-3), then the average, $\sigma$, and the Process Capability Index (Cpk and Cp) values are displayed. The USL and LSL values are displayed on the right side of the plot and all other values are displayed at the top of the plot.

Cpk is defined as the lower of Cpl and Cpu where

$$Cpl = \frac{\text{Average} - \text{LSL}}{3\sigma}, \quad Cpu = \frac{\text{USL} - \text{Average}}{3\sigma}$$

and,

If the option to calculate the standard deviation was selected in the Graph window, then $\sigma$ and the average are displayed above the trend plot. Also, note that in the plot

• points within $\pm3\sigma$ limits are plotted as squares,
• points within the $\pm3\sigma$ limit but outside the $\pm\sigma$ limits are plotted as circles, and
• points outside the $\pm3\sigma$ limits are marked with an X.
\[ C_p = \frac{(C_p + C_l)}{2} \]

- points outside the \pm 3\sigma limits are marked with an X.

4. To display a table of the points outside the specification limits, choose Out Of Limits from the Trend Plot dialog box (Fig. 6-3). A table of the outlying points displays (Fig. 6-5).

<table>
<thead>
<tr>
<th>Record</th>
<th>ID</th>
<th>Comment</th>
<th>Date</th>
<th>Stress</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>1</td>
<td></td>
<td>02/03/95</td>
<td>70.4</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td></td>
<td>02/03/95</td>
<td>-26.0</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td></td>
<td>02/03/95</td>
<td>-26.5</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
<td></td>
<td>02/03/95</td>
<td>28.2</td>
</tr>
</tbody>
</table>

Figure 6-5  Table of Points Outside the Limits

5. Close the Graph window. You have the following options:
- You can generate another trend plot with different settings for the same data file by repeating steps 5 through 8 of this procedure, or
- You can generate a trend plot for another data file by closing the Graph window and redisplaying the Data Editor window.
6.3 DISPLAYING GRAPHS

Use the Graph Retrieval option in the Analysis menu to recall graphs, display linear regressions, thermal stress graphs, graph subtractions, and diffusion coefficient calculations.

To display a graph:

1. Choose Graph Retrieval from the Analysis menu.

![Figure 6-6  Analysis Menu](image)

A dialog box displays prompting for the graph filename.

![Figure 6-7  Specifying the Graph File](image)
2. Enter the name of the file and press ENTER, or choose OK. To change the directory, enter the path and directory name (end with a backslash []) and press ENTER. The selected graph displays.

![Sample Graph](image)

Figure 6-8 Sample Graph

Graph Options

You have the following options in the Graph menu:

- Use the File menu to load, save, rename, and merge graph files.
- Use the Font menu to set font styles for graph text.
- Use the Points menu to change the color and shape of graph points and to connect points.
- Use the Axis Scale menu to resize the graph.
- Use the Curve Fitting menu to fit a line or polynomial up to an order 3 to the data.
- Use the Smoothing menu to reduce or eliminate noise.
- Use the Color menu to specify colors for the different graph attributes.

6.4 USING THE FILE MENU IN THE GRAPH WINDOW

When in a graph window, you can modify a graph using the File, Font, Points, Axis Scale, Curve Fitting, Smoothing, or Color menu items.

Use the File menu items in the graph window to load, save, rename, and merge graph files.

To load another graph:

1. Choose Load from the File menu.
2. Enter the desired filename and press ENTER. The graph is loaded and displayed in the Data Editor window.

6.4.1 RENAMING A FILE
Refer to Section 5.2.3, “Renaming a File,” for details on renaming a file.

6.4.2 MERGING GRAPHS
Refer to Section 5.2.4, “Merging Data Files,” for details on how to merge graphs into the Data Editor window.

6.4.3 PRINTING A GRAPH
Refer to Section 5.2.5, “Printing Data Files,” for details on how to print graph files.

6.4.4 DELETING GRAPHS
To delete a graph:
1. Choose Delete from the File menu. A dialog box displays.
2. Enter the filename of the graph that you wish to delete.
3. Press OK.

6.4.5 CLOSING A GRAPH WINDOW
To close a graph window:
Choose Close from the File menu. The active graph window closes.

6.5 USING THE FONT MENU IN THE GRAPH WINDOW
Use the Font menu to modify the font, font style, and color of the text used in a graph.

6.5.1 SETTING A GRAPH HEADER STYLE
Use the Graph Header Style sub menus to set the font, font style, color and font size of the graph header.

To set a font:
1. Choose Font/Set/Graph Header/Style from the font cascading menus. A font dialog box displays.
2. The sample area of the dialog box displays the selected font settings. Choose the desired font from the dialog box.
3. Press OK. The text font for the graph header is changed.
To set a font style:
1. Choose Font/Set/Graph Header/Style from the font cascading menus.
2. Choose the desired font style from the dialog box.
3. Press OK.

To underline text in the graph header:
1. Choose Font/Set/Graph Header/Underline from the font cascading menus. A check displays next to the menu item indicating that it is selected. Choose Underline again to unselect this item.

To change the color of the graph header:
1. Choose Font/Set/Graph Header/Color from the font cascading menus. A color dialog box displays.
2. Modify the dialog box to the desired setting. Press OK.

6.5.2 SETTING THE AXIS HEADER STYLE
Use the Axis Header Style submenus to modify the font, font style, and color of the axis header text used in a graph. Refer to Section 6.5.1, “Setting a Graph Header Style,” for instructions on doing this.

6.5.3 SETTING THE AXIS LABEL
Use the Axis Label submenus to modify the font style, and color for the axis label used in a graph. Refer to Section 6.5.1, “Setting a Graph Header Style,” for instructions on doing this.

6.5.4 SETTING THE SUBTITLE
Use the Subtitle submenus to modify the font style, and color for the subtitle text used in a graph. Refer to Section 6.5.1, “Setting a Graph Header Style,” for instructions on doing this.

6.5.5 SETTING THE POINTS
Use the Points submenus to modify the font, highlight and font style of points used in a graph. Refer to Section 6.5.1, “Setting a Graph Header Style,” for instructions on doing this.

6.5.6 SAVING THE GRAPH FILE
Use Save menu to save the graph file with the defined settings.
Choose Save from the Font menu. The graph is saved to the default filename.
6.6  CHANGING AND SETTING POINTS

Use the Points menu to change the shape and color of the points displayed on a graph as well as connecting specified points.

6.6.1  SETTING THE COLOR OF POINTS

Use the Color menu to change the color of the points in a graph. Refer to Section 6.5.1, “Setting a Graph Header Style,” for instructions on doing this.

6.6.2  SETTING THE SHAPE OF POINTS ON A GRAPH

Use the Shape menu to change the shape of the points displayed on a graph. You can change the shape of displayed points to any of the following:

- Rectangle
- Circle
- Triangle
- Star
- Dot
- Cross

To change the shape of a point:

1. Choose Shape from the Points menu. A cascading menu displays.
2. Choose the desired shape from the cascading menu.
3. Position the cross-hair cursor on a point in the graph. The shape of each of the points on that line changes to the selected shape.

6.6.3  CONNECTING AND DISCONNECTING LINES ON A GRAPH

Use the Connect menu to connect and disconnect lines on a graph from point to point.

To connect points:

Choose Connect from the Points menu. All points on the graph are connected.

To disconnect points:

Choose Disconnect from the Points menu. All points on the graph are disconnected.

6.7  USING THE AXIS SCALE

Use the Axis Scale menu to move the X-Y axis scale of a graph.

To position the axis scale to the top left:

1. Choose Top Left from the Axis Scale menu. A cross-hair cursor displays.
2. Position the cursor over the desired point in the top left area of the graph and click. The graph redisplay at the new position in the Graph window.

To position the axis scale to the bottom right:
1. Choose Bottom Right from the Axis Scale menu. A cross-hair cursor displays.
2. Move the cursor over the desired point in the bottom right area of the graph and click. The graph redisplay at the new position in the Graph window.

6.8 CURVE FITTING
Use the Curve Fitting menu to adjust the curve fitting to either a linear, order 2 or order 3.

To do a linear curve fitting:
1. Choose Linear from the Curve Fitting menu.
2. Click on the desired start and end points. A linear curve displays for the selected points.

To do an order 2 curve fitting:
1. Choose order 2 from the Curve Fitting menu.
2. Click on the desired start and end points. An order 2 curve fitting displays for the selected points.

To do an order 3 curve fitting:
1. Choose order 3 from the Curve Fitting menu.
2. Click on the desired start and end points. An order 3 curve fitting displays for the selected points.

6.9 SMOOTHING
Use the Smoothing menu to reduce the amount of noise found in a graph. Smoothing can be performed for three, five, seven or nine points.

3-point smoothing
- Choose 3 point from the Smoothing menu. The graph redisplay with smoothing for every three points.

5-point smoothing
- Choose 5 point from the Smoothing menu. The graph redisplay with smoothing for every five points.

7-point smoothing
- Choose 7 point from the Smoothing menu. The graph redisplay with smoothing for every seven points.
9-point smoothing

- Choose 9 point from the Smoothing menu. The graph redisplayed with smoothing for every nine points.

6.10 SETTING THE COLORS OF A GRAPH

Use the Color menu to set or change the color of the background, axis frame, grid, or plot area of the graph.

To change the background color:

1. Choose Background from the Color menu.
2. The color dialog box displays. Select the desired color and click OK. The graph redispalyed with the selected background color.

To change the axis frame color:

1. Choose Axis Frame from the Color menu.
2. The color dialog box displays. Select the desired color and click OK. The graph redispalyed with the selected axis frame color.

To change the grid color:

1. Choose Grid from the Color menu.
2. The color dialog box displays. Select the desired color and click OK. The graph redispalyed with the selected grid color.

To change the color of the plot area:

1. Choose Plot Area from the Color menu.
2. The color dialog box displays. Select the desired color and click OK. The graph redispalyed with the selected plot area color.
7 DATA ANALYSIS

This chapter describes the operation of the instrument. It describes how to analyze the data by displaying graphs of file subtraction, thermal stress, elastic and expansion coefficient calculations, and diffusion coefficients.

The procedures in this chapter assume a knowledge of instrument controls and basic operations such as starting and shutting down the instrument. These operations are described in Chapter 3, "Basic Skills." If you have not already done so, read Chapter 3 before proceeding.

7.1 DIFFUSION COEFFICIENT

To calculate the diffusion coefficient:

1. To calculate the diffusion coefficient and plot it in a Graph window, choose Diffusion Coefficient from the Analysis menu.

2. The system displays a dialog box prompting for the desired filename.

![Filename Dialog Box](image)

Figure 7-1 Filename Dialog Box

Enter or choose the desired filename.

3. A graph displays and you are prompted to select two points on the graph by double-clicking on the points. Note that diffusion coefficient graphs can be calculated and displayed only for Stress-Time graphs.
The following is a sample diffusion coefficient graph.

![Graph showing diffusion coefficient extraction](image)

**Figure 7-2  Diffusion Coefficient Extraction**

For details on the equation used to calculate the diffusion coefficient, see Chapter 9, "Theory of Operation."

4. Double-click on the Control-menu box to return to the Analysis menu. To redisplay another graph with different attributes, repeat Steps 2 and 3.

### 7.2 MATERIALS DATABASE

Use the Materials Database option on the Edit menu to display a list of available elastic and expansion coefficients. You can add new coefficients, and delete or change the existing coefficients.

**To display the elastic and expansion coefficients:**

1. Choose Materials Data Base from the Edit menu. An Elastic and Expansion Database window displays (see Fig. 7-3).
2. The window can display up to 12 coefficients at one time. Press PAGE DOWN to display the next 12 coefficients (if any) and PAGE UP to return to the previous display.

3. To edit an existing coefficient:
   - Use TAB to move the cursor to the coefficient line and click once to highlight the first field for editing.
   - After editing each field, press TAB to move to the next field. To erase the entry in a field, use the backspace key. To exit a field without editing it, press TAB. When you press TAB in the last field of the line, the cursor moves to the next line.

4. To add a new coefficient on a blank line:
   - Move the cursor to the line above which you want to insert a blank line.
   - Choose Insert (Fig. 7-3). A blank line is displayed with the first field selected.
   - Enter the name of the material in the first field, the biaxial modulus (in Pa) in the second field, and the linear expansion coefficients in the next three columns. After entering a value in a field, press TAB to move to the next field. To erase the entry in a field, use the backspace key. When you TAB in the last field of the line, the cursor moves to the next line.
7.3 ELASTIC AND EXPANSION COEFFICIENT CALCULATION

The Expansion and Coefficient option under the Analysis menu calculates the film thermal expansion coefficient and biaxial modulus. For an explanation of the equation used in this calculation, see Chapter 9, "Theory of Operation."

To display a graph of the elastic and expansion coefficient calculation:

1. Use the Stress-Temperature mode to run two temperature cycles on two different substrates with the same film.
   
   Note: For best results use slow heating or cooling (<5°C per minute) to minimize the lag of the wafer temperature behind the heating stage. See Section 4.1.5, "Stress-Temperature Measurement," for details.

2. Use the procedures in Section 6.1, "Creating Graphs," to create and save graphs for both the data files.

3. Choose Elastic & Expansion from the Analysis menu. The following dialog box displays:

   ![Elastic & expansion Dialog Box](image)

   **Figure 7-4** Elastic and Expansion Dialog Box

4. Enter the path and name of the first graph file and press TAB. To display a list of available graph files, choose the Files button.

5. Enter the path and name of the second graph file and press ENTER. To display a list of available graph files, choose the Files button. A Graph window appears displaying the curves of the two substrates.

   Figure 7-5 is a sample graph displaying the cooling curves of two substrates—silicon and GaAs—coated with a tungsten film.
6. In the Graph window, click on two points to plot and display the expansion coefficient. Figure 7-6 is a sample plotted expansion coefficient.
The average values of the expansion coefficient and the biaxial modulus display in a dialog box (Fig. 7-7).

<table>
<thead>
<tr>
<th>Temperature range</th>
<th>40 °C to 400 °C</th>
</tr>
</thead>
<tbody>
<tr>
<td>Materials</td>
<td>GaAs Si 100 Film</td>
</tr>
<tr>
<td>Expansion (ppm/c)</td>
<td>6.402 3.448 4.501</td>
</tr>
<tr>
<td>Biaxial modulus (Dyne/cm²)</td>
<td>1.239E+012 1.805E+012 5.415E+012</td>
</tr>
</tbody>
</table>

File 1: C:\WINDOWS\FLEXUS\W1-GAAS.GRP
File 2: C:\WINDOWS\FLEXUS\W1-SI.GRP

Figure 7-7 Average Values of the Expansion Coefficient and Biaxial Modulus

7.3.1 THERMAL STRESS

Use the Thermal Stress option to display the thermal stress superimposed on the stress-temperature measurement data.

To display the thermal stress superimposed on the Stress-Temperature graph:

1. Choose Thermal Stress from the Analysis menu. The following dialog box displays:

![Thermal stress dialog box]

2. Enter the path and name of the file and press ENTER, or choose the Files button to display a list of available files. To change the directory, enter the path and directory name (end with a backslash \\). Press TAB to move to the next field.

3. Enter the From temperature and To temperature values. Press TAB to move to the next field.

4. Enter the substrate material name. Enter the desired substrate name, or use the drop-down menu to select the desired substrate. Press TAB to move to the next field.
5. Enter the film material name. Enter the symbol, for example, W for tungsten, or use the pull-down menu to select the desired film material. Choose the OK button or press ENTER to measure the thermal stress.

Figure 7-9 is an example of film tungsten (W) on GaAs.

![Graph](image)

**Figure 7-9  Thermal Stress Superimposed on Stress-Temperature Measurement Data**

6. Double-click in the Control-menu box of the Graph window and then the Thermal Stress menu to redisplay the Main menu.

### 7.4 GRAPH SUBTRACTION

The graph subtraction feature is used for

- Simple graph subtraction for comparison or correction, and
- Multiple films on the substrates

In the case of multi-film use, measure the wafer with Film 1 (thickness $t_1$) using the Stress-Temperature method and create a graphic file called File2. Assume the stress measured for this film is $\sigma_1$. Then measure the wafer with Film 1 + Film 2 (thickness $t_2$) and create a graphic file called File1. Note: Use the same temperature recipe for both graphs. The stress of the film with Film 1 + Film 2 is

$$\sigma = \frac{(\sigma_1 t_1 + \sigma_2 t_2)}{t_2} = \frac{\sigma_1 t_1}{t_2} + \sigma_2$$
As $\sigma_1$ was measured in File 2, $\sigma_2$ is calculated by subtracting $\frac{\sigma_1}{t_2}$ from File 1. This is done by inserting the value of $\frac{t_1}{t_2}$ as the multiplier of File 2 as $\sigma_2 = File 1 - \frac{t_1}{t_2} \times File 2$. Note that this equation and procedure are valid only if the Film 1 stress is not affected by Film 2.

To subtract graphs:

1. Choose Graph Subtraction from the Analysis menu. The following dialog box displays:

   ![Graph Subtraction Dialog Box](image)

   **Figure 7-10  Graph Subtraction Dialog Box**

2. Enter the path and filename of the first graph file or choose the Files button to display a list of available files. To change the directory, enter the path and directory name (end with a backslash []). Press TAB to move to the next value.

3. Enter the path and filename of the second graph file or choose the Files button to display a list of available files. To change the directory, enter the path and directory name (end with a backslash []). Press TAB to move to the next value.

4. Tab to the next field if you are accepting the default value in the multiplier 1 field. Enter a different multiplier value (if the films are of different thicknesses) and press TAB.

5. Tab to the next field if you are accepting the default value in the multiplier 2 field. Enter a different multiplier value (if the films are of different thicknesses) and press TAB.

6. The cursor moves to the Curve Smoothing field. Set the option button to Y to use the curve smoothing feature. This feature smooths the second graph to fit a third-order polynomial.

7. Press TAB to move to the New Graph Header field. Enter a new header.
8. Choose OK to generate the subtracted graph.
9. Choose Save from the File menu to save the graph.

7.5 COMPARING RECORDS

The Record Comparison option in the Analysis menu compares the deflection curves of the first stress and single stress measurements. You can use this option only if you selected the option to save scan (extension.SCN) files when scanning the wafer in First Stress and Single Stress Measurement modes. Also note that the Stress-Time and Stress-Temperature Measurement modes do not create scan files.

To compare records:

1. Choose Record Comparison from the Analysis menu. The following dialog box displays:

![Record Comparison Dialog Box](image)

Figure 7-11 Record Comparison Dialog Box

2. Enter the name of the file and press ENTER, or use [↑] or [↓] to select the filename. The Record Comparison window displays (Fig. 7-12).
### Figure 7-12 Record Comparison Window

3. The window can display up to 14 records at one time. To display the next 14 records, press PAGE DOWN; to return to the previous set of records, press PAGE UP. To display the last screen, press CTRL+PAGE DOWN; to return to the first 14 records, press CTRL+PAGE UP.

4. To edit a record, use TAB to move to the record. You can edit the ID, Film Thickness (if measured), and Substrate Thickness fields.

5. To select the records for comparison:
   - Use TAB to move to a record that was created during the First Measurement mode (it typically displays N/A in the Film Thickness field).
6. Choose Tag as First or press CTRL+F from the Edit menu:

<table>
<thead>
<tr>
<th>Comment</th>
<th>Date</th>
<th>Film</th>
<th>Sub.</th>
<th>Temp.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>92/03/95</td>
<td>N/A</td>
<td>730</td>
<td>20</td>
</tr>
<tr>
<td>2</td>
<td>92/03/95</td>
<td>16000</td>
<td>730</td>
<td>20</td>
</tr>
<tr>
<td>3</td>
<td>92/03/95</td>
<td>2580</td>
<td>730</td>
<td>20</td>
</tr>
<tr>
<td>4</td>
<td>92/03/95</td>
<td>N/A</td>
<td>730</td>
<td>20</td>
</tr>
</tbody>
</table>

Figure 7-13 Edit Menu for Record Comparison

An F appears next to the record indicating it is selected as the first measurement. To untag the record, choose Untag (Both) or press CTRL+U from the Edit menu.

7. Use TAB to move to a record with the same ID as the first measurement record but created during the Single Stress Measurement mode and displaying a stress measurement. Choose Tag As Single or press CTRL+S from the Edit menu. An S appears next to the record indicating that it is selected as the stress measurement. To untag the record, choose Untag (Both) or press CTRL+U from the Edit menu.

Note: To select and display only one record, tag the same record as First and Single. In this case, the tagged record can be a first or single.
8. After selecting the two records, choose Deflection from the menu (Fig. 7-13). A deflection graph similar to the following displays:

![Deflection Graph](image)

**Figure 7-14 Deflection Graph**

In the plot,

- the deflections of the first measurement are plotted as circles,
- the deflections of the second measurement are plotted as squares, and
- the difference between the two measurements are plotted as triangles.

**To display the stress segmentation plot:**

1. Choose Segmentation from the Stress menu in the Record Comparison window.

![Stress Menu](image)

**Figure 7-15 Stress Menu**

A difference graph is displayed or if you selected only one record, the deflection for that record is displayed. Figure 7-16 is a sample difference graph.
Figure 7-16 Difference Graph

You can compare any scanned segment and display the local radius of curvature and stress of the segment (if two records were tagged):

- A blinking cursor is displayed at the first point of the plot. Use [→] to move up through the points and [←] to move backward through the points.
- To delete a point, move the blinking cursor over the point and press D. To restore the deleted point, move the cursor to the place where the point was deleted and press R.
- To calculate the stress and radius for selected points, press ENTER after deleting undesired points.
To display the stress uniformity plot:

1. Choose Uniformity from the Stress menu. The system displays a dialog box displaying values for film thickness and substrate thickness at five locations (Fig. 7-17).

![Stress uniformity dialog box]

Figure 7-17 Displaying the Stress Uniformity Values

2. To make changes, place the cursor in the desired field. Press TAB to move from one field to another. The cursor moves left to right, first in the Film Thickness, then the Substrate, and the Location fields. Choose the Calc Stress button to calculate and plot the stress across the wafer. Figure 7-18 is an example of a stress uniformity plot.

![Stress uniformity graph]

Figure 7-18 Sample Stress Uniformity Plot

Using this option, you can allow for film and substrate thickness nonuniformities. Note that these results are correct for radially symmetrical nonuniformities only.

3. When you have finished examining the stress uniformity plot, close the graph to return to the Record Comparison window.
7.5.1 DISPLAYING DEFLECTION MAPS

Use the Deflection Maps option to display a 3-D view of the deflection. By taking several measurements at different angles you can display a complete 3-D map of the deflection over the wafer surface. The deflection can be plotted as the difference of two groups of measurements (for example, before deposition and after deposition of a film) or as an absolute deflection of a single measurement.

To display 3-D deflection maps:

1. Measure the wafer at different angles before deposition, after deposition, or at both stages using the procedures in Sections 4.1.2, "First Stress Measurement," and 4.1.3, "Single Stress Measurement." During the measurements use the following guidelines:
   - Measure the wafer at different angles relative to the scan axis. After each measurement, manually move the wafer to the next angle. Make sure that the angles selected include 0° and 90°. For example, to measure the wafer at angular increments of 15°, you need to take measurements at 0°, 15°, 30°, 45°, 60°, 90°, 105°, 120°, 135°, 150°, and 165°.
   - Use the procedures in Section 3.11, "Using Wafer Locator Rings," to position the wafer. In addition, make the 0° orientation measurement with the flat or notch on the right side of the instrument. This means that the wafer locator ring should be positioned with the 270° mark pointing to the front of the instrument. For each successive measurement, rotate the locator with the wafer counterclockwise. For example, to measure the wafer at angular increments of 15°, position the locator ring in the following sequence: 270, 255, 240, 225, 210, 195, 180, 165, 150, 135, 120, and 105. Note: 8-in. wafers do not use locator rings but should be positioned in the same way.
   - The IDs for each measurement in a group should be identical and in the format xxxx-###, where xxxx is any character (including spaces) and ### is the angular orientation. For example, the IDs for wafer T12 measured every 15° would be as follows:

   T12 - 0       T12 - 60       T12 -120
   T12 - 15      T12 - 75       T12 -135
   T12 - 30      T12 - 90       T12 -150
   T12 - 45      T12 -105       T12 -165

   NOTE: When comparing two scans (before and after deposition), the first four ID characters must be identical for both scans and the orientation steps used must also be the same. Also, the dash must be in the fifth column and the ### portion must be right justified.

2. Choose 3DPlotting from the Analysis menu, as shown in Figure 7-19.
A Plot3D menu similar to the following displays:

3. Choose Open from the File menu. Select the desired filename and choose the OK button or press [↓] to select the filename and press ENTER. The Group Selection dialog box displays:

4. Select the desired records. After selecting the records, choose OK to display the deflection window (Fig. 7-22).
Figure 7-22 Displaying the Deflection Map File

To change the viewing angle use the following icons or key combinations:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Key Combination</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="F7" /></td>
<td>F7</td>
<td>30° increment</td>
</tr>
<tr>
<td><img src="image2" alt="CTRL+F7" /></td>
<td>CTRL+F7</td>
<td>Face on view</td>
</tr>
<tr>
<td><img src="image3" alt="ALT+F7" /></td>
<td>ALT+F7</td>
<td>10° increment</td>
</tr>
<tr>
<td><img src="image4" alt="F8" /></td>
<td>F8</td>
<td>30° increment</td>
</tr>
<tr>
<td><img src="image5" alt="CTRL+F8" /></td>
<td>CTRL+F8</td>
<td>Face on view</td>
</tr>
<tr>
<td><img src="image6" alt="ALT+F8" /></td>
<td>ALT+F8</td>
<td>10° increment</td>
</tr>
<tr>
<td><img src="image7" alt="F9" /></td>
<td>F9</td>
<td>45° increment</td>
</tr>
<tr>
<td><img src="image8" alt="CTRL+F9" /></td>
<td>CTRL+F9</td>
<td>90° increment</td>
</tr>
<tr>
<td><img src="image9" alt="ALT+F9" /></td>
<td>ALT+F9</td>
<td>15° increment</td>
</tr>
<tr>
<td>Icon</td>
<td>Key Combination</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td></td>
<td>F10</td>
<td>45° increment</td>
</tr>
<tr>
<td></td>
<td>CTRL+F10</td>
<td>90° increment</td>
</tr>
<tr>
<td></td>
<td>ALT+F10</td>
<td>15° increment</td>
</tr>
<tr>
<td></td>
<td>F11</td>
<td>Compress the view of the wafer vertically by half a unit. The default unit is 1 unit high.</td>
</tr>
<tr>
<td></td>
<td>F12</td>
<td>Stretch the view of the wafer vertically by half a unit. The default unit is 1 unit high.</td>
</tr>
</tbody>
</table>
8 MAINTENANCE

This chapter is intended for the key person responsible for the maintenance of the Tencor FLX-2320 instrument. The following information is provided in this chapter:

- Calling Tencor Service and other related information
- Getting information about the hardware using the Diagnostics and Configuration options
- Verifying the calibration of the instrument
- Troubleshooting minor problems
- Moving the laser beam

8.1 SERVICE POLICY

The Tencor Instruments Service Organization is available to you in the United States, Europe, and Japan. We also have representatives in The People’s Republic of China, Taiwan, Hong Kong, Singapore, and India.

Tencor Instruments’ commitment is to provide a technical response by telephone within 24 hours, often within the same business day. The commitment for on-site repair is 48 hours.

- The service organization is available for unpacking and installing your instrument. To schedule the installation, contact the Customer Service Administrator at (800) 722-6775.

- In the United States, service requests are processed through a central number located in California. Call (800) 722-6775 Monday through Friday between 6:00 A.M. and 6:00 P.M., Pacific Standard Time, to arrange for service or repair work or to order replacement parts.

- Standard on-site service hours are Monday through Friday, 8 A.M. to 5 P.M., local time. You can arrange for other hours through a customized service contract.

- Tencor Instruments provides service beyond the original warranty period of 1 year as needed. Repair work performed after the original warranty expires is guaranteed for 3 months. Full service contracts extend the warranty period and can be customized to your specific requirements.

Tencor Instruments encourages you to attend a maintenance and repair training course for your instrument. In general, trained customers experience greater instrument uptime and make better use of Tencor Instruments service resources. Your sales or service engineer can provide you with the course and fee schedule.
8.2 MAINTENANCE

Use the procedures in the manuals to maintain the components as required. Note the following:

- The instrument should be calibrated by Tencor Instruments once a year. Do not calibrate the instrument yourself; only Tencor Service should calibrate the instrument.

- The instrument could require cleaning or adjustment if the reflected light intensity is consistently low (see Section 8.5, “Calibration,” for details on testing the intensity). Call Tencor Service to schedule the necessary maintenance; do not attempt to clean or adjust the instrument yourself. However, before calling Tencor Instruments, use the procedures in Section 8.3, “Troubleshooting,” to make sure that the low light intensity is not caused by any of the listed reasons.

8.3 TROUBLESHOOTING

If the measured intensity is zero or low, do the following before calling Tencor Instruments:

- Make sure the instrument is turned on.
- Make sure a sample is loaded and the sample is reflective.
- Make sure the beam is impinging on the substrate by using the following procedure:
  1. Open the door to the instrument (Fig. 3-1). If not already removed, loosen the four thumbscrews that hold down the hot plate cover and remove the thumbscrews and the cover. Place a bare, flat silicon wafer, polished face up, in the shallow depression on the measurement platform. Close the instrument door.
  2. Choose Intensity Check from the Utilities menu. The instrument moves the beam to the center of the stage, measures the light intensity and displays it in the Intensity Check dialog box. The value displayed in the window should read 2.0–4.0.

8.4 DIAGNOSTICS

Use the Diagnostics option to get hardware information such as laser intensities, table leveling, and reflected light intensity. You can correct the table leveling using the information displayed in the Diagnostics dialog box. We recommend that you check the hardware configuration in the Diagnostics dialog box when the instrument is installed.

To display the Diagnostics dialog box:

1. Open the door to the instrument (Fig. 3-1). If not already removed, loosen the four thumbscrews that hold down the hot plate cover and remove the thumbscrews and
the cover. Place a bare, flat silicon wafer, polished face up, in the shallow depression on the measurement platform. Close the instrument door.

2. Choose Diagnostics from the Utility menu. The instrument checks the reflected light intensity (SUM) and the beam positions (DIFF) and displays the information along with other hardware information in the Diagnostics dialog box:

```
RS232: CONNECTED
Temperature controller: ON
Parallel port printer: CONNECTED
7 serial ports installed
Motor functioning: OK
670 nm intensity: HIGH Sum = 4.981 Diff = -0.069
Table leveling (670 nm): OK
750 nm intensity: HIGH Sum = 4.571 Diff = -0.064
Table leveling (750 nm): OK
```

Figure 8-1 Diagnostics Dialog Box

3. The following list explains the information displayed. Note that the fields displayed in the Diagnostics dialog box depend on your instrument configuration.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232</td>
<td>Status of the cable connector used to check the instrument temperature. The default setting is Connected.</td>
</tr>
<tr>
<td>Parallel port printer</td>
<td>Status of the parallel printer port.</td>
</tr>
<tr>
<td>Temperature controller</td>
<td>Status of temperature controller.</td>
</tr>
<tr>
<td>Serial ports installed</td>
<td>Number of serial ports installed.</td>
</tr>
<tr>
<td>Motor functioning</td>
<td>Status of the motor.</td>
</tr>
<tr>
<td>670 nm intensity SUM = ; DIFF =</td>
<td>SUM is the reflected light intensity; DIFF is the beam position for the 670-nm laser.</td>
</tr>
<tr>
<td>Table leveling (670 nm)</td>
<td>Indicates if the measurement platform needs to be leveled by turning the leveling screw (Fig. 3-1) clockwise or counterclockwise.</td>
</tr>
<tr>
<td>750 nm intensity SUM = ; DIFF =</td>
<td>SUM is the reflected light intensity; DIFF is the beam position for the 750-nm laser.</td>
</tr>
</tbody>
</table>
Field                        Description
Table leveling
(750 nm)                    Indicates if the measurement platform needs to be leveled by turning the leveling screw (Fig. 3-1) clockwise or counterclockwise.

4. When finished reading the information, choose OK to close the window and return to the Main menu.

5. Remove the wafer from the measurement platform.

8.5 CALIBRATION

The Tencor FLX-2320 should be calibrated once a year. Schedule an appointment with Tencor Service to calibrate the instrument.

CAUTION: The following procedures are for verification only. Do not attempt to calibrate the instrument yourself. If your test values fall outside the specified ranges, call Tencor Instruments Service. However, before calling Tencor Instruments, use the procedures in Section 8.3, "Troubleshooting," to make sure that the low light intensity is not caused by any of the reasons listed.

The Calibration procedure is password protected and can only be accessed by Tencor Service to calibrate the instrument.

8.5.1 INTENSITY CHECK

Use the Intensity Check option on the Utilities menu to check reflected light intensity and position.

To check the light intensity and position:

1. Open the furnace door. Install the wafer locators. See Section 3.11, "Using Wafer Locator Rings" for details. Place the bare, silicon wafer on the three quartz pins (Fig. 3-1). Close the furnace door.

2. Choose Intensity Check from the Utilities menu (Fig. 8-2).

Figure 8-2 Utilities Menu
3. The instrument checks and displays the Intensity and Position values. Compare your readings to the following table. Note that the following values are the limits for a bare, flat silicon wafer.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Intensity</td>
<td>2–4</td>
</tr>
<tr>
<td>Position</td>
<td>±0.1</td>
</tr>
</tbody>
</table>

If the intensity and position are outside the limits defined in the above table, contact Tencor Service. Do not calibrate the instrument. However, before calling Tencor Instruments, use the procedures in Section 8.3, “Troubleshooting,” to make sure that the low light intensity is not caused by any of the reasons listed.

4. When done checking the intensity and position, choose Cancel to close the window and return to the Main menu.

5. Open the furnace door and remove the wafer from the furnace chamber.

8.6 MOVING THE LASER BEAM

The Move Laser Beam option on the Utilities menu provides three movements of the laser:

- Moving (jogging) the laser in small increments
- Setting the laser at the center of the sample
- Moving the laser a desired distance

To move the laser beam:

1. Open the furnace door. Install the wafer locators. See Section 3.11, “Using Wafer Locator Rings,” for details. Place the bare, silicon wafer on the three quartz pins (Fig. 3-1). Close the furnace door.

2. Choose Move Laser Beam from the Utilities menu:

![Utilities Menu](image)

Figure 8-3 Utilities Menu
3. The Laser Position dialog box displays as shown in Figure 8-4.

![Move laser dialog box]

**Figure 8-4  Laser Position Dialog Box**

4. Choose the desired option. Use the following list for details on each option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move To</td>
<td>Moves the laser a specified distance from its current position. Displays a window for entering the desired distance in mm. Enter the distance and choose Move to. Enter a positive (+) value to move the laser beam to the right and a negative (−) value to move the laser beam to the left.</td>
</tr>
<tr>
<td>&lt; &gt;</td>
<td>Moves the laser beam left or right at increments of 0.5 mm. Use [←] to move the beam left and [→] to move the beam right.</td>
</tr>
<tr>
<td>Set at center</td>
<td>Automatically moves the laser to the center of the sample.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancels the operation.</td>
</tr>
</tbody>
</table>

5. When done, choose Cancel to return to the Main menu.

6. Open the furnace door and remove the wafer from the furnace chamber.

### 8.7 RADIUS OF CURVATURE VERIFICATION

Note that the following procedure is optional. Before each instrument is shipped, its radius of curvature is verified and a Certification of Accuracy (Fig. 8-8) is included with the instrument. This calibration option is only available for the 6-in. and 8-in. wafer instruments.
You can test the accuracy using either or both of the following mirrors:

- 100-mm diameter, Optical Flat Mirror with 1/10 wavelength
- 100-mm diameter, 20-meter radius (concave) Quartz Mirror

You can also order special rings for positioning the mirrors in the instrument. Note that the mirror positioning rings are optional. If you do not have the rings, you can manually center the mirror on the measurement platform. Call Tencor Instruments for ordering the mirrors and the rings.

Figures 8-5, 8-6, 8-7, and 8-8 display a sample mirror, the 6-in. mirror positioning ring, the 8-in. mirror positioning ring, and a sample Certification of Accuracy.

![Mirror Positioning Ring](image)

**Figure 8-5  Mirror**

The mirror positioning ring displayed in the following figure is used for the instrument with the 6-in. wafer option.
The mirror positioning ring displayed in the following figure is used for the instrument with the 8-in. wafer option.
The Certification of Accuracy certifies the radius of curvature for the instrument. It includes information such as the customer name, the date the test was done, the type of test done, the reference standards used, and the certified results.

**CERTIFICATION OF ACCURACY**

Customer: ABC Manufacturing  
**Date of Test:** 9/15/93

Sales Order No.: 23436

Item Tested: Concave Mirror

**Part No.:** 236349  
**Serial No.:** OFCLE002-3

Type of Test Performed: First Measurement Technique for Radius of Curvature

Certified Results:
- Radius of Curvature: 20.150 m concave
- Radius of Curvature when measured with FLX-2320: 21.003 m concave*

Reference Standards Used:
- 20.2527 m concave mirror  
  (Certification of Accuracy by ZYGO CORP.)
- **Serial No.:** 2195FLE002-2

Laboratory conditions during the test

**Temperature:** 24° C

Tencor Instruments certifies that the data consists of 10 measurements made under the conditions specified producing the results-reported. The result reported is the average of these measurements.

Note: *The result of measurement with FLX-2320 is larger due to the thickness of the mirror.

Signed:

Dated:

*Figure 8-8 Certification of Accuracy*
To verify the measured radius of curvature:

1. Open the door to the instrument (Fig. 3-1). If they are not already removed, loosen the four thumb screws that hold down the hot plate cover and remove the thumb-screws and the cover. Remove the wafer locator, if present.

2. If you do not have the mirror positioning ring:
   - Position the flat or concave mirror, face up, in the shallow depression on the measurement platform. Manually center the mirror in the depression.
   - Close the instrument door.
   - Proceed to step 4.

3. If you have the mirror positioning ring:
   - Place the mirror ring in the shallow depression on the measurement platform. Position the mirror ring so that the mirror positioning score (see Figs. 8-6 and 8-7) is toward the left side of the instrument (opposite the Dial Indicator).
   - Place the flat or concave mirror, face up, into the center of the mirror ring. Position the mirror so that the positioning line on the mirror matches the positioning score on the mirror ring. Also, move the mirror so that it touches the mirror ring on the left and the back (Fig. 8-9).

---

**Figure 8-9  Mirror Positioned in the Ring**
• Close the instrument door.
• Proceed to step 4.

4. Choose First (No Film) from the Measure menu.

![Figure 8-10 Stress Measurement Menu](image)

5. Perform a first stress measurement using the procedures in Section 4.1.2, “First Stress Measurement.”

6. After the measurement is complete, the instrument displays the substrate deflection graph. Note the measured radius displayed above the graph. Check it with the radius specified in the Certification of Accuracy. If the radii do not match, call Tencor Instruments.

7. Close the graph windows to return to the Main menu.

8.8 SYSTEM CONFIGURATION INFORMATION

The Configuration option on the Main menu displays additional system information such as Model Type, Max Scan Length, RAM drive, and Motor Speed. You might need this information to help Tencor Service troubleshoot problems. Note that you cannot change any of the information displayed in this window.

To display the Configuration dialog box:

1. Choose Config from the View menu.

![Figure 8-11 Choosing the Configuration Menu](image)
The Configuration dialog box displays:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value 1</th>
<th>Value 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODEL TYPE</td>
<td>F2320,m</td>
<td></td>
</tr>
<tr>
<td>TABLE AXIS TO INDICATOR</td>
<td>12.40</td>
<td>Inches</td>
</tr>
<tr>
<td>WAFFER DETECTOR DISTANCE (TABLE)</td>
<td>13.12</td>
<td>Inches</td>
</tr>
<tr>
<td>STEPS/REV</td>
<td>200</td>
<td>Steps</td>
</tr>
<tr>
<td>MAX SCAN LENGTH</td>
<td>202.00</td>
<td>mm</td>
</tr>
<tr>
<td>CHANNEL RATIO</td>
<td>10.00</td>
<td></td>
</tr>
<tr>
<td>MOTOR SPEED</td>
<td>15</td>
<td></td>
</tr>
<tr>
<td>MOTOR ACCELERATION</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>CENTER EXCLUSION</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>AXIS - WAFFER CENTER</td>
<td>3.750</td>
<td>Inches</td>
</tr>
<tr>
<td>IMPINGEMENT ANGLE</td>
<td>0.00698</td>
<td>RAD</td>
</tr>
<tr>
<td>OVER TEMPERATURE</td>
<td>500</td>
<td>°C</td>
</tr>
<tr>
<td>WAFFER DETECTOR DISTANCE</td>
<td>13.12</td>
<td>Inches</td>
</tr>
<tr>
<td>SERIAL NO</td>
<td>4195</td>
<td></td>
</tr>
</tbody>
</table>

Figure 8-12 Configuration Dialog Box

2. When you have finished reading the information, choose OK to return to the Main menu.
9 THEORY OF OPERATION

This chapter describes the theory of operation of the Tencor FLX-2320, and the equations used to calculate the diffusion, expansion, and elastic coefficients.

The FLX-2320 measures the changes in the radius of curvature of a substrate caused by deposition of a stressed thin film. The stress in the thin film is calculated from the radius of curvature of the substrate using the following equation:

\[ \sigma = \frac{Eh^2}{(1-v)6Rt} \]

where

- \( \frac{E}{(1-v)} \) is the biaxial elastic modulus of the substrate (1.805E11 Pa for 100 silicon wafers)
- \( h \) is the substrate thickness (m)
- \( t \) is the film thickness (m)
- \( R \) is the substrate radius of curvature (m)
- \( \sigma \) is the average film stress (Pa)

The following picture is a schematic drawing of substrate deformed to radius \( R \) by the deposition of a film. In this case, the film is under compression deforming the substrate.
To illustrate the stress calculation, suppose that a 100 mm silicon wafer, 525 μm thick, is deformed to a radius of 30 m by the deposition of a surface film of thickness 7500 Å. Since the biaxial elastic modulus of 100 silicon is $1.802 \times 10^{11}$ Pa, the stress calculated according to Equation 1 is

$$
\sigma = \frac{1.805 \times 10^{11} \times (525 \times 10^{-6})^2}{(6 \times 30 \times 7500 \times 10^{-10})} = 3.69 \times 10^8 Pa = 369 MPa
$$

The average radius $R_1$ of the bare substrate is obtained by measuring $\theta$ as a function of $x$ and performing a linear regression. $\frac{1}{R_1}$ equals half the slope obtained from the linear regression. After the film is deposited, the substrate deforms to a new radius $R_2$. Since the stress is proportional to $\frac{1}{R}$, it follows that

$$
\frac{1}{R} = \frac{1}{R_2} - \frac{1}{R_1}
$$

or

$$
R = \frac{1}{\left(\frac{1}{R_2} - \frac{1}{R_1}\right)} = \frac{(R_1R_2)}{(R_1 - R_2)}
$$

The thin film stress is now determined by using the effective radius $R$ in the equation described above. To calculate the stress, the substrate radius must be measured before and after film deposition.

Single wavelength machines can run into destructive interference from transparent films such as silicon nitride. The Dual Wavelength system solves this problem by choosing automatically between two lasers and using the stronger reflection for measurement.
DIFFUSION COEFFICIENT CALCULATION

The diffusion coefficient is calculated by the least square fitting to the diffusion equation into a finite film:

\[ \sigma = \sigma_0 - \Delta\sigma \left[ 1 - \left( \frac{8}{\pi^2} \right) \sum_{1}^{\infty} \left( \frac{1}{(2n-1)^2} \right)^2 \exp \left( \frac{(1-2n)^2 \pi^2}{4L^2} Dr \right) \right] \]

where
\( \sigma \) is the stress at time t
\( \sigma_0 \) is the initial stress
\( \Delta\sigma \) is the total stress change after completion
\( n \) is a running index from 1 to infinity
\( L \) is the film thickness
\( D \) is the diffusion coefficient
\( t \) is the time

For details on using this option, see Section 6.3, “Displaying Graphs.”

ELASTIC AND EXPANSION COEFFICIENT CALCULATION

The stress change with temperature in the elastic range is governed by the following equation:

\[ \frac{d\sigma}{dT} = \left( \frac{E}{1-v_f} \right) (\alpha_s - \alpha_f) \]

where
\( \frac{d\sigma}{dT} \) is the derivative of stress versus temperature
\( \left( \frac{E}{1-v_f} \right) \) is the biaxial modulus of the film
\( \alpha_s \) is the substrate thermal expansion coefficient
\( \alpha_f \) is the film thermal expansion coefficient

The above equation has two unknowns—\( \alpha_f \) and \( \left( \frac{E}{1-v_f} \right) \). To solve these, two temperature cycles are done with two different substrates and the software solves two equations. For details on using this option, see Section 7.3, “Elastic and Expansion Coefficient Calculation.”
APPENDIX A – SPECIFICATIONS

PERFORMANCE SPECIFICATIONS

**Substrate Diameter**
100-mm (4-in.), 125-mm (5-in.), 150-mm (6-in.), and 200-mm (8-in.) wafers. Note: The 200-mm (8-in.) wafer is an option.

**Measurement**
Speed: 5 sec. for 150-mm wafer
Range: $2 \times 10^7$ to $4 \times 10^7$ dyne/cm$^2$ (stress upper limit increases with shorter scan length)
RMS Noise: 0.0001 m$^{-1}$ (radius=10,000 meters) at room temperature
Resolution: 0.00003 m$^{-1}$ (33 kilometers)
Minimum Scan Step: 0.02 mm
Maximum Points Per Scan: 1250
Minimum Radius: 2.0 m (for 80 mm scan length)

**Temperature Range**
Standard: Room temperature to 500° C
Optional: -65° C to 500° C. (Factory installed only)

**Repeatability**
The main source of the repeatability error is the replacement accuracy of wafers. The typical Tencor Instruments 1σ error in the $R$ value is $1 \times 10^7$ dyne/cm$^2$ for a 1-μm film on a 525-μm silicon substrate. Thicker films and thinner substrates result in smaller errors and thicker films and thinner substrates result in larger errors. The following table lists stress errors for different film and silicon substrate combinations.

<table>
<thead>
<tr>
<th>Substrate Thickness</th>
<th>100,000</th>
<th>10,000</th>
<th>1,000</th>
<th>100</th>
</tr>
</thead>
<tbody>
<tr>
<td>375 μm</td>
<td>0.5x10^6</td>
<td>0.5 x 10^7</td>
<td>0.5 x 10^8</td>
<td>0.5 x 10^9</td>
</tr>
<tr>
<td>525 μm</td>
<td>1.0x10^6</td>
<td>1.0 x 10^6</td>
<td>1.0 x 10^8</td>
<td>1.0 x 10^9</td>
</tr>
<tr>
<td>625 μm</td>
<td>1.4x10^6</td>
<td>1.4 x 10^7</td>
<td>1.0 x 10^8</td>
<td>1.4 x 10^9</td>
</tr>
<tr>
<td>675 μm</td>
<td>1.7x10^6</td>
<td>1.7 x 10^7</td>
<td>1.7 x 10^8</td>
<td>1.7 x 10^9</td>
</tr>
</tbody>
</table>

OPERATING SPECIFICATIONS

**Light Source**
Two lasers: 4-mW solid state (GaAlAs) laser with wavelength 670 nm and 4-mW solid state (GaAlAs) laser with wavelength 750 nm
PHYSICAL DIMENSIONS

FLX-2320 Instrument 46 cm (18 in.) x 46 cm (18 in.) x 56 cm (22 in.) plus computer

WEIGHT

System 45.5 kg (100 lb)
Shipping Weight 72.7 kg (160 lb)

OPERATING ENVIRONMENT

Temperature 18–22°C (64–72°F)
Air Quality Clean room Class 100 or better
Gas Connections Inert gas flow rate: 2–10 CFH
(Optional)

Cooling gas flow rate: Up to 500 CFH; pressure not to exceed 40 psi. Note: The cooling gas cools from 500°C to room temperature in 60 min.; liquid nitrogen cools to room temperature in 30 min.

Nitrogen flow rate: Up to 50 CFH. The atmosphere inside the measurement chamber is replaced by low-humidity nitrogen. This makes it possible to take very low temperature measurements without condensation or ice formation on the wafer.

System Power Instrument: Standard 150 mm wafer: 11 amp., 115 V, 50/60 Hz
Optional 200 mm wafer: 13 amp., 230 V, 50/60 Hz
Computer: 5.4 amp., 115 V, 50/60 Hz

COMPUTER AND PERIPHERALS

Computer 486DX 66 MHz
Hard Disk 540 MB
Monitor VGA Color Monitor
Floppy Diskette Drive 3.5-in. high density (1.44 MB)
Printer Hewlett-Packard Deskjet 520, recommended
Comm Port

One male serial RS-232 port connector for use as SECS-II port. Note: A gender changer and a null modem adapter is provided for use with the standard SECS cable.
This appendix lists selected constants and conversions.

1 MPa = $10^7$ dynes/cm$^2$
1 GPa = $10^{10}$ dynes/cm$^2$

Silicon Biaxial Moduli$^1$:

(100) $1.805 \times 10^{11}$ Pa
(111) $2.290 \times 10^{11}$ Pa

This appendix describes the optional cooling stage for the Tencor FLX-2320. The cooling stage provides measurement temperatures of 500° C to -65° C. The cooling stage in addition to the standard FLX-2320 measurement platform and its components is surrounded by an assembly through which inert nitrogen gas flows to form a blanket around the measurement platform and the wafer.

A quartz plate is placed over the wafer to protect it from water condensation. Liquid nitrogen runs through the heater to cool the measurement platform. Note that the procedures for all measurement modes are identical to the standard instrument procedures.

Figure C-1 shows the cooling stage in detail.

![Diagram of Cooling Stage](image)

**Figure C-1  Cooling Stage**

The following sections provide instructions on installing and operating the Tencor FLX-2320 with the cooling stage.
UTILITY SPECIFICATIONS

The Tencor FLX-2320 cooling stage option requires the following utilities:

- Inert gas at 2–5 CFH to surround the wafer. This prevents condensation or ice formation on the wafer and the quartz plate at very low temperatures.
- Inert gas at 40 CFH to provide a dry blanket around the measurement stage. This also prevents condensation or ice formation on the wafer and the quartz plate at very low temperatures.
- Liquid nitrogen at approximately 20 liters/hour.

Figure C-2 is a detailed block diagram showing all the gas and liquid nitrogen connections.

![Diagram of Inert Gas and Liquid Nitrogen Connections]

Figure C-2 - Inert Gas and Liquid Nitrogen Connections
INSTALLATION

To install the cooling stage option:

1. Prepare the various gas and liquid nitrogen connections. See the previous section “Utility Specifications,” for the required utilities and Figure A-2 for the various connections. The instrument gas and liquid nitrogen connections consist of five, assembled, 3/8-in. Swagelok bulkhead unions (Swagelok Part No. SS-600-61). To connect the gas and liquid nitrogen pipes (stainless steel or Teflon), remove the nut, the back ferrule, and the front ferrule on each Swagelok. Place the nut and the two ferrules on each pipe and then connect it to the corresponding Swagelok.

2. Use the procedures in Section 2.4.2, “Installing the Instrument,” to connect the various instrument and computer components, set up the default process program, and level the measurement platform. Note: Do not follow the procedures in the section labeled “To connect the inert and cooling gas connections.”

3. Proceed to the following section “Operation,” for procedures to use the cooling stage to measure stress.

OPERATION

NOTE: Tencor recommends that you read the following procedure before beginning the measurements.

To use the cooling stage option:

1. Use the procedures in Section 4.1.2, “First Stress Measurement,” to measure the stress on an undeposited wafer.

2. After the wafer has been deposited, take a single-stress measurement without the quartz plate:
   - Install the wafer locator ring on the hot plate measurement platform and place the deposited wafer, face up, in the ring. For details on using locator rings, see Section 3.11, “Using Wafer Locator Rings.” Note that you can start the single-stress measurements without replacing the hot plate cover.
   - Close the instrument door.
   - Use the procedures in Section 4.1.3, “Single Stress Measurement,” to measure the stress on the wafer after deposition.
   - Note the measured stress value displayed at the end of the measurement.

3. For the stress-temperature measurement, cover the wafer with the quartz plate. Replace the hot plate cover and tighten the thumbscrews. Close the instrument door. Then use the procedures in Section 4.1.5, “Stress-Temperature Measurement,” to measure stress as a function of temperature.
NOTE: If your recipe starts with heating and ends with cooling, turn on the fan for the heating cycle. When the temperature cools to room temperature, turn off the fan and use steps 4 and 5 to turn on the gas and liquid nitrogen flows. Do not leave the fan on when operating below room temperature; this causes heavy ice or water condensation on the wafer and the quartz plate.

4. Start the flow of liquid nitrogen by opening the valve connecting the liquid nitrogen tank to the Tencor FLX-2320. See Figure C-2 for the location of the valve.

5. Start the flow of both inert gases (wafer and measurement stage) by opening their valves. See Figure C-2 for the location of the valves.

6. Create a graph of the results of the stress-temperature measurement using the procedures in Section 6.1, "Creating Graphs." The graph dialog box (Fig. 6-1) includes fields for specifying the X- and Y-axis. When you select either axis to be Stress, an additional field called Initial Stress is displayed next to the axis field. Specify the stress value obtained in step 2 (measurement without the quartz plate) of this procedure as the Initial Stress.


GLOSSARY

**Autoscan.** A scan in which the start and end scan positions are defined as 10% in from the edge of the wafer.

**Elastic Modulus.** The biaxial elastic modulus of the substrate to be used in stress calculations.

**First (No Film) Measurement.** A single scan performed on a wafer before deposition and used as a reference for subsequent scans.

**Hole Diameter.** The diameter of the center region of the substrate to be skipped.

**Intrinsic Stress.** The stress of a film at the deposition temperature.

**Process Program.** A set of parameters specifying information, such as the wafer diameter for measurement, elastic modulus, and substrate thickness.

**Ramp Value.** The rate of change of temperature in degrees Celsius (°C) per minute during a heating or cooling cycle.

**Recipe.** A recipe contains data that the instrument uses to automatically take a temperature measurement. The information in a recipe determines the setting of a stress-temperature measurement, the target temperature, and the number of ramping readings for each measurement.

**Record Comparison.** A comparison of the deflection curves of the first stress and single stress measurements. Record Comparison also allows you to do stress and stress uniformity calculations as well as view intensity curves. This feature is only available on measurements where scan data has been saved.

**Scan.** Action performed when the Tencor FLX-2320 optical system and measurement stage are used to inspect wafers.

**Single Stress Measurement.** A single scan, performed on a wafer after film deposition, used to measure the induced stress.

**Stress-Temperature Measurement.** A scan used to measure stress as a function of temperature on a wafer after deposition. The instrument uses temperature cycling to reveal stress changes. Temperature cycling causes stress changes due to thermal expansion, mismatch, volume changes, and plastic deformations.

**Stress-Time Measurement.** Scans used in measuring the stress over a specified period of time, on a wafer after deposition. This type of measurement reveals the kinetics, such as wafer absorption in oxides, densification, phase transformations, and stress relaxation, of a wafer.

**Temperature Controller.** Instrument that displays the temperature heating and cooling cycle. The controller is located on the front panel of the measurement unit.

**Thermal Stress.** The film stress change between the deposition temperature and the measurement temperature.

**Wafer Diameter.** The diameter of the wafer in millimeters (mm).
INDEX

A
Air quality, specification 2-3, A-2
Application, definition 1-2
Arrow keys 1-2

B
Beam attenuator 3-2

C
Cables, installation 2-7
Calibration, instrument
  - Light intensity check 8-4
  - Troubleshooting 8-2
Capability index (Cpk) 6-6
Certification of accuracy, radius 8-9
Closing windows 3-14
Command buttons 3-9
Computer, specifications
  - Floppy diskette drive A-2
  - Hard disk A-2
  - Monitor A-2
  - Printer A-2
Concave quartz mirror 8-7
Constants, instrument B-1
Control menu 3-3
Controls, instrument
  - Beam attenuator 3-2
  - Dial indicator 3-2
  - Fan switch 3-2
  - Heater switch 3-2
  - Laser keyswitch 3-2
  - Leveling screw 3-2
  - Main on/off switch 3-2
  - Temperature display 3-2
Conventions
  - Terminology 1-2
  - Typographic formatting 1-2
Conventions, menus 3-6
Cooling gas flow rates A-2
Cooling gas specification 2-7
Cooling stage option
  - Gas specifications C-2
  - Inert gas flow C-1
  - Installation C-3
  - Installation procedures C-3
  - Instrument schematic C-1
  - Liquid nitrogen C-1
  - Liquid nitrogen specifications C-2
  - Operation C-4
  - Operational procedures C-4
  - Stage schematic, in detail C-2
  - Utilities C-2
Copying files 5-8
Cpk (capability index) 6-6
Customer service administrator 8-1

D
Data
  - Display windows, using 3-12
Data analysis
  - Comparing records 7-9
  - Displaying deflection maps 7-15
  - Displaying graphs 6-8
Data Display
  - Closing window 3-14
Data files
  - Copying files 5-8
  - Deleting 5-9
  - Editing records 5-6
  - Exporting files 5-10
  - Generating graphs 6-1
  - Merging files 5-3
  - Moving blocks 5-7
  - Printing blocks 5-4
  - Printing files 5-3
  - Recalculating stress 5-9
  - Renaming files 5-3
  - Selecting record blocks 5-7
  - Trend plots, generating 6-4
Data windows, using 3-12
Deflection maps option
  - Changing the viewing angle 7-17
  - Measurement angles 7-15
  - Measurement guidelines 7-15
  - Procedure 7-15
  - Scan data file window 7-16
  - Specifying measurement IDs 7-15
Deleting files 5-9
Diagnostics
  - Hardware information 2-11, 8-3
  - Window 2-10, 8-3
Dial indicator 2-7, 3-2
Dialog box
  - System message 3-12
Dialog boxes, using 3-6
Diffusion coefficient graphs, displaying 7-1

E
Elastic & expansion coefficient option 7-4
   Biaxial modulus, average 7-6
   Cooling curves graph 7-5
   Expansion coefficient plot 7-5
   Expansion coefficient, average 7-6
Elastic coefficients
   Adding 7-3
   Displaying 7-2
   Editing 7-3
Expansion coefficients
   Adding 7-3
   Displaying 7-2
   Editing 7-3
   List 7-3
Exporting, data files 5-10

F
Facility specifications 2-3
   Air quality 2-3
   Gas connections 2-3
   System power 2-3
   Temperature 2-3
Fan switch 3-2
Features, instrument 2-1
Field 1-3
File subtraction option
   Multi-film use 7-7
   Procedure 7-8
   Simple file subtraction 7-7
First program window 4-4
First stress measurement
   First program window 4-4
   Procedure 4-4

G
Gas connections
   Cooling gas specification 2-7
   Inert gas specification 2-7
   Nitrogen specification A-2
   Schematic 2-6
Gas connections, specification 2-3, A-2
Gas connections, standard instrument
   Procedure 2-6
   Schematic of instrument back 2-6
   Specifications of gas flow 2-7
Graphs
   Diffusion coefficient extraction 7-2
   Elastic & expansion coefficient calculation 7-4
Generating 6-1
   Graph specification parameters 6-2
   Retrieving option 6-8
   Stress temperature 4-14
   Stress time 4-10

H
Hardware information
   Configuration window 8-11
   Diagnostics window 8-2
   Heat switch 3-2

I
Inert gas flow rates A-2
Inert gas specification 2-7
Inert gases, cooling stage option C-1
Installation, instrument
   Facility specifications 2-3
   Operating environment 2-3
   Procedures 2-5
   Shipping damage 2-3
   Software installation 2-11
Instrument, schematic 2-2, 3-1
   Intensity, limits 8-5

L
Laser beam adjustments
   Moving beam incrementally 8-6
   Moving the beam specified distance 8-6
   Setting beam at center 8-6
Laser keyswitch 3-2
Lasers, information vii
Leveling screw 3-2
Light source, lasers vii, A-1
Locator ring
   150-mm (6-in.) wafer 3-17
   200-mm (8-in.) ring 3-18
   200-mm (8-in.) wafer 3-18
   200-mm wafer 3-17
   Measurement modes 3-17
   Using 3-17, 3-18
   Wafer sizes available 3-17
Low intensity, problems 8-2
Lower specification limit (LSL) 6-5

M
Main on/off switch 3-2
Maintenance, instrument
   Adjustment 8-2
   Calibration 8-2
   Cleaning 8-2
   Managing files
Index 3

Copy 5-8
Manual
Conventions 1-2
Description 1-1
Terminology 1-2
Measured intensity, problems 8-2
Measurement specifications A-1
Menu 1-3, 3-4
Menu bar 3-3
Menus
Choosing a menu item 3-5
Description 3-6
Opening or closing 3-5
Using 3-5
Merging, data files 5-3
Messages
Error 3-12
System 3-12
Minimizing a window 3-13
Mirror positioning rings 8-7
Mirrors, radius of curvature verification 8-6
Modulus correction 6-2
Monitor, damage
Shockwatch 2-4
Tiltwatch 2-5
Moving a window 3-14

N
Nitrogen atmosphere, option A-2

O
Operating environment 2-3
Operating safety viii
Operating specifications
Light source A-1
Optical flat mirror 8-6
Option buttons 3-10
Overview, instrument 2-1
Features 2-1
Schematic drawings 2-2

P
Physical dimensions, instrument A-2
Printer A-2
Printing, data files 5-3
Process program 1-3
Editing 4-1
Fields 4-3
Selecting 4-1
Process program fields
Auto scan 4-3,
Elastic modulus 4-3

Hole diameter 4-3
Laser selection 4-3
Low intensity alarm 4-3
Maximum scan points 4-3
Save scan 4-3
Substrate thickness 4-3
Units 4-3
Wafer diameter 4-3

Q
Quartz plate, cooling stage option C-1

R
Radius of curvature, verification
Certification of accuracy 8-9
Mirror positioning ring, 6-in. option 8-8
Mirror positioning ring, 8-in. option 8-8
Mirror positioning rings 8-7
Mirror, concave 8-7
Mirror, optical flat 8-6
Verification procedures 8-10
Record, comparison 7-9
Renaming files 5-3
Repeatability, specification A-1
Resizing a window 3-14
Restoring a window 3-13

S
Safety, operating viii
Scan 1-3
Scroll bars, using 3-11
Scrolling
Using keys 3-11
Using scroll bar 3-11
Service hours, on-site 8-1
Service Policy 8-1
Service requests 8-1
Shipping contents 2-3
Shipping weight A-2
Shockwatch monitor 2-4
Shutting down, instrument 3-23
Silicon biaxial moduli B-1
Single stress measurement mode
Procedure 4-7
Single screen 4-7, 4-9, 4-11
Software
Installation 2-12
Upgrade installation 2-12
Specifications, operating
Air quality A-2
Gas connections A-2
System power A-2
Index-4

Temperature A-2
Specifications, performance
  Measurement A-1
  Reliability A-1
  Substrate diameter A-1
  Temperature range A-1
Standard deviation 6-5
Starting, instrument 3-15
Stress measurement modes
  First stress 4-4
  Single stress 4-7
  Stress-temperature 4-10
  Stress-time 4-8
Stress temperature measurement mode
  Graph 4-14
  Procedure 4-10
Stress time measurement mode
  Graph 4-10
  Procedure 4-8
Substrate diameter supported A-1
Substrate diameter, performance specification A-1
System Components 2-2
System message dialog box 3-12
System power, specification 2-3, A-2

T
Temperature display 3-2
Temperature range, specifications A-1
Temperature, operating 2-3, A-2
Terminology, manual 1-2
Thermal stress option 7-6
  Thermal stress graph 7-7
Tiltwatch monitor 2-5
Title bar 3-3
Trend plots
  Cpk index 6-6
  Generating 6-4
  Sample 6-6
  USL and LSL values 6-6
Troubleshooting problems 8-2
Typographic conventions, manual 1-2

U
Upper specification limit (USL) 6-5

W
Window 1-4
Windows
  Closing 3-14
  Control menu 3-3
  Dialog boxes 3-6
  Menu 3-4